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บทคดัย่อ 
(Abstract) 

 
โครงงานน้ีเป็นการศึกษาโครงสร้างของเคร่ืองแอลกอฮอล์ด้วยลมหายใจ โดยเป็นการ

ประยุกต์บอร์ดไมโครคอนโทรเลอร์ Arduino UNO R3 กบั sensor วดัแอลกอฮอล์ TGS 2620 โดย
ใช้ภาษา C เป็นตวัสั่งการ โดยเม่ือเราเป่าลมหายใจไปยงัตวัเซนเซอร์ก็จะท าการรับค่าและสามารถ
ค านวณระดบัแอลกอฮอล์ออกมาเป็นเปอร์เซ็นตมิ์ลลิกรัมแสดงออกท่ีหนา้จอ LCD ซ่ึงหากมีค่าเกิน 
50 %mg ก็จะสั่งให้ Buzzer มีเสียงเตือน และ LED กะพริบ จากการทดสอบพบว่าเคร่ืองวดัระดบั
แอลกอฮอล์ดว้ยลมหายใจท่ีพฒันาข้ึนน้ีมีประสิทธิภาพท่ีใกลเ้คียงกบัเคร่ืองจริงท่ีไดม้าตรฐาน โดยมี
ความคลาดเคล่ือนอยู่ในเกณฑ์ท่ียอมรับได้ แสดงว่าเคร่ืองวดัระดบัแอลกอฮอล์ด้วยลมหายใจน้ี
สามารถน าไปใชง้านเทียบเท่าเคร่ืองเป่าวดัแอลกอฮอล์ท่ีมีมาตรฐานได ้และยงัมีตน้ทุนในการผลิตท่ี
ต ่ากวา่เคร่ืองในทอ้งตลาดเป็นอยา่งมาก 
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บทที ่ 1 
บทน ำ 

 
1.1   บทน ำ 

ความรู้และการประยุกต์ใช้ประโยชน์จากไมโครคอนโทรลเลอร์ นบัว่ามีความส าคญัและ
จ าเป็นต่อโลกปัจจุบนัเป็นอยา่งมาก เทคโนโลยถูีกสร้างและพฒันาข้ึนแทบทุกวินาทีเพื่อช่วยอ านวย
ความสะดวกให้แก่มนุษย ์ทั้งดา้นการส่ือสาร การแพทย ์การคมนาคม ความบนัเทิง และทุกๆอยา่งท่ี
ดูจะถูกท าให้เป็นเร่ืองง่ายยิ่งข้ึนไปเร่ือยๆ ซ่ึงทั้งน้ีพื้นฐานของไมโครคอนโทรลเลอร์ถือเป็นอีกหน่ึง
ปัจจยัส าคญัท่ีจะช่วยท าใหเ้กิดส่ิงเหล่าน้ี 

ไมโครคอนโทรลเลอร์ มาจากค าสองค าบวกกนั คือ ไมโคร กบั คอนโทรลเลอร์  ไมโคร
แปลวา่ เล็กๆ ส่วนคอนโทรลเลอร์แปลวา่ระบบควบคุม ดงันั้น เม่ือรวมสองค าเขา้ดว้ยกนั ก็แปลว่า 
ระบบควบคุมขนาดเล็ก ซ่ึงเทียบไดก้บัระบบคอมพิวเตอร์หน่ึงชุด กล่าวคือ ไมโครคอนโทรลเลอร์
ได้รวบรวม  ระบบประมวลผล CPU (Central Processing Unit) หน่วยความจ า (Memory) และ
พอร์ต (I/O Port) ไวใ้นโมดูล เดียวกนัซ่ึงแตกต่างจากไมโครเซสเซอร์ตรงท่ี ไมโครโปรเซสเซอร์
จะตอ้งต่ออุปกรณ์ หน่วยความจ าและพอร์ตอินเตอร์เฟสขา้งนอก เน่ืองจากไมโครคอนโทรลเลอร์มี
ขนาดเล็ก มียดืหยุน่ และความสามารถสูงจึงนิยมฝังไวใ้นอุปกรณ์ทางไฟฟ้าหรือ อิเล็กทรอนิกส์ เพื่อ
ควบคุมการท างานของอุปกรณ์นั้น เช่น ทีวี เคร่ืองซกัผา้ มือถือ รีโมท กล่อง ECU รถยนต ์เคร่ืองบิน 
หรือ แมก้ระทัง่ บางส่วนของยานอวกาศ 

 
1.2   หลกักำรและเหตุผล 
 ปัจจุบนั เทคโนโลยไีดเ้ขา้มาเป็นส่วนหน่ึงในชีวิตของมนุษยอ์ยา่งขาดไม่ได ้ซ่ึงท าให้มนุษย์
มีความสะดวกสบาย กล่าวคือ สามารถลดขั้นตอนท่ีซบัซอ้นและระยะเวลาในการท างานหน่ึงๆลงได ้
และยงัคงมีประสิทธิภาพ เช่นการใชอิ้นเทอร์เน็ตอ่านข่าวแทนหนงัสือพิมพ ์การโทรศพัทแ์ทนการ
ส่งจดหมาย ตลอดจนการน าเทคโนโลยีมาช่วยในการทดลองทางวิทยาศาสตร์ซ่ึงอาจไม่จ  าเป็นตอ้ง
พึ่งกระบวนการทดลองทางวทิยาศาสตร์อีกต่อไปนัน่เอง 

เคร่ืองวดัระดับแอลกอฮอล์ด้วยลมหายใจนั้ น ก็เป็นอีกหน่ึงตัวอย่างหน่ึงของการน า
เทคโนโลยีเขา้มาใชแ้ทนท่ีการทดลองทางวทิยาศาสตร์ ท าให้ไม่ตอ้งพึ่งพาขั้นตอนท่ียุง่ยากของการ
ตรวจวดั ซ่ึงอุปกรณ์ดงักล่าวถูกใชโ้ดยเจา้หน้าท่ีต ารวจท่ีท าหน้าท่ีตรวจสอบผูก้ระท าความผิดตาม
กฎจราจร โดยต้องการความรวดเร็วและแม่นย  าในการตรวจสอบว่ามีผูใ้ดเมาแล้วขับหรือไม่ 
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อุปกรณ์น้ีจึงถูกสร้างข้ึนมาดว้ยเทคโนโลยสีมยัใหม่ใหมี้ประสิทธิภาพแต่ลดระยะเวลาและขั้นตอนท่ี
ยุง่ยากในการตรวจวดัออกไปได ้
 โครงงานน้ีไดน้ าเสนอการพฒันาและสร้างเคร่ืองวดัระดบัแอลกอฮอล์ด้วยลมหายใจ บน
พื้นฐานของโปรแกรมภาษา C ควบคุมบอร์ดไมโครคอนโทรลเลอร์ Arduino UNO R3 ท่ีติดตั้ ง 
Sensor TGS 2620 ตรวจวดัระดบัสารท่ีเป็นแอลกอฮอล์ในลมหายใจ ท่ีสามารถแปรผลและค านวณ
ระดบัแอลกอฮอลใ์นร่างกายมนุษยไ์ด ้
 

1.3   วตัถุประสงค์ 
1. เพื่ อ ศึ ก ษ า  Sensor TGS2620 ใ น ก า ร ใช้ ง าน แ ล ะ เช่ื อ ม ต่ อ กั บ บ อ ร์ ด

ไมโครคอนโทรลเลอร์ Arduino 
2. เพื่อศึกษาวธีิการใชง้านของบอร์ดไมโครคอนโทรลเลอร์ Arduino 
3. เพื่อศึกษาการท างานและประยุกต์การใช้งานโปรแกรม Arduino IDE บน

พื้นฐานภาษา C กบัไมโครคอนโทรลเลอร์ Arduino 
4. เพื่อสามารถใช้โปรแกรม Arduino IDE บนพื้นฐานภาษา C มาควบคุมการ

ท างานของบอร์ดไมโครคอนโทรลเลอร์ Arduino และ Sensor ได ้
5. เพื่อให้สามารถน าความรู้ท่ีไดจ้ากการศึกษาทฤษฎีต่างๆ มาประยุกตแ์ละพฒันา

เคร่ืองวดัระดบัแอลกอฮอลด์ว้ยลมหายใจ และใชไ้ดจ้ริงได ้
6. เพื่อพฒันาเคร่ืองวดัระดบัแอลกอฮอลท่ี์มีตน้ทุนถูกกวา่ทอ้งตลาดได ้
7. เพื่อฝึกการท างานเป็นทีม การแกปั้ญหาต่างๆท่ีเกิดข้ึน 

 
1.4   ขอบเขตงำน 

1. ศึกษาและพัฒนาเคร่ืองว ัดระดับแอลกอฮอล์ด้วยลมหายใจด้วย  Microcontroller 
Arduino UNO R3 ท่ีท  างานร่วมกนักบั Sensor TGS2620 

2. ศึกษาและพัฒนาโปรแกรม Arduino IDE บนพื้นฐานภาษา C เพื่อใช้สั่ งการให้
ไมโครคอนโทรลเลอร์ Arduino UNO R3 ท างานเพื่อวดัและค านวณระดบัแอลกอฮอล์
ในลมหายใจ 

3. ศึกษาและพฒันาโปรแกรม Arduino IDE บนพื้นฐานภาษา C ให้สามารถรับขอ้มูลจาก
ไมโครคอนโทรลเลอร์ Arduino UNO R3 แลว้ท าการแสดงผลไปยงัจอ LCD 
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1.5   ขั้นตอนกำรด ำเนินงำน 
 1.   ศึกษา คน้ควา้ขอ้มูล 

2.   เขียนโครงการและเสนอโครงการกบัอาจารยท่ี์ปรึกษา 
      3.   ศึกษาเก่ียวกับไมโครคอนโทรลเลอร์ Arduino UNO R3 และ Sensor วดัแอลกอฮอล ์
TGS2620 
      4.   เก็บขอ้มูลเปรียบเทียบระหวา่งเคร่ืองเป่าวดัแอลกอฮอลท่ี์ไดม้าตรฐานกบั Sensor ท่ีใช ้

5.   หาค่าดรรชนีความสัมพนัธ์ของเซนเซอร์เพื่อแปลงจากหน่วย Volt เป็นเปอร์เซ็นต์
มิลลิกรัม 

6.   ออกแบบ Flow chart และเขียนโปรแกรม 
7.   เช่ือมการท างานของ Sensor TGS2620 และบอร์ดไมโครคอนโทรลเลอร์ Arduino UNO 

R3 ดว้ยโปรแกรม Arduino IDE บนพื้นฐานภาษา C 
8.   ทดลอง สรุปผลการทดลองและเขียนรายงาน 
9.   น าเสนอโครงงาน 

 

1.6   ผลทีค่ำดว่ำจะได้รับ 
1. มีความรู้เก่ียวกับโปรแกรม Arduino และโปรแกรมภาษา C และสามารถน ามา

ประยกุตใ์ชใ้หเ้ก่ียวขอ้งกบัหวัขอ้โครงงานได ้
2. มีความรู้เก่ียวกบั Microcontroller Arduino และสามารถ น ามาประยุกต์ใชใ้ห้เก่ียวขอ้ง

กบัหวัขอ้โครงงานได ้
3. มีความรู้เก่ียวกบั Sensor ท่ีใช้ตรวจจบัก๊าซหรือไอสารในอากาศและการใช้งานของ 

Sensor TGS 2620 
4. สามารถแกปั้ญหาจากการปฏิบติังานจริง เช่น การแกปั้ญหาต่างๆ การท างานเป็นทีม 
5. สามารถสร้างเคร่ืองวดัระดบัแอลกอฮอลด์ว้ยลมหายใจท่ีใชไ้ดจ้ริง และมีประสิทธิภาพ 
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บทที ่ 2 
หลกัการและทฤษฎทีีเ่กีย่วข้อง 

 
2.1   บทน า 
 เน้ือหาในบทน้ีจะกล่าวถึงหลักการ แนวคิดและทฤษฎีท่ีเก่ียวข้องกับเคร่ืองวดัระดับ
แอลกอฮอล์ด้วยลมหายใจ โดยเร่ิมตั้งแต่ความรู้เบ้ืองตน้และคุณสมบติัของแอลกอฮอล์ ตลอดจน
เคร่ืองมือ อุปกรณ์และวิธีการท าเคร่ืองมือตรวจวัดแอลกอฮอล์ในลมหายใจท่ีสามารถใช้ได้ เพื่อ
น ามาศึกษาเป็นแนวทางไปสู่การพฒันาเคร่ืองวดัระดบัแอลกอฮอลด์ว้ยลมหายใจ 
 

2.2   แอลกอฮอล์และเคร่ืองดื่มทีม่แีอลกอฮอล์ 
 แอลกอฮอล์ท่ีอยู่ในเคร่ืองด่ืมท่ีมีแอลกอฮอล์ เช่นเหล้า เบียร์ วิสก้ี บร่ันดี เป็นตน้นั้นเป็น
แอลกอฮอลช์นิดเอทานอลหรือเรียกวา่เอทิลแอลกอฮอล์ ซ่ึงถึงแมจ้ะเผาผลาญให้พลงังานแก่ร่างกาย
ได้ แต่ไม่มีสารอาหารอ่ืนเลย เคร่ืองด่ืมท่ีมีแอลกอฮอล์แต่ละประเภทจะมีปริมาณของเอทานอล
แตกต่างกนั เช่น เบียร์มีปริมาณแอลกอฮอล์น้อยประมาณ 4 - 6% โดยปริมาตร ส่วนสุราชนิดต่างๆ 
เช่น วิสก้ี บร่ันดี วอดกา้ สุรา40ดีกรี เป็นเหลา้ชนิดกลัน่มีปริมาณแอลกอฮอล์สูงกว่า ประมาณ 40 - 
50% โดยปริมาตรเอทานอลมีสมบติัเป็นของเหลว ใส ไม่มีสี มีกล่ินหอม ติดไฟให้ความร้อนสูง ไม่
มีเขม่าละลายน ้ าไดดี้ เตรียมไดจ้ากการหมกัแป้ง น ้ าตาลหรือผลไม ้โดยมียสีตเ์ป็นตวัเร่ง เพื่อเปล่ียน
แป้งจากพืชให้เป็นน ้ าตาล แลว้เปล่ียนจากน ้ าตาลเป็นเอทานอล จากนั้นน าเอทานอลท่ีได้ไปกลัน่
เพื่อให้บริสุทธ์ิมากข้ึน วตัถุดิบท่ีใช้หมกัเป็นได้ทั้ งพืชและผลิตภณัฑ์ของพืชบางชนิด เช่น ออ้ย 
น ้ าตาล กากน ้ าตาล กากออ้ย แป้ง มนัส าปะหลงั มนัเทศ ธัญพืชต่างๆ เช่น ขา้วโพด ขา้ว ขา้วสาลี 
ขา้วบาร์เลย ์ขา้วฟ่าง เป็นตน้ 
 
 2.2.1   คุณสมบัติทัว่ไปของแอลกอฮอล์ 

แอลกอฮอล์จะมีส่วนประกอบเป็นไฮโดรคาร์บอน (Hydrocarbon) และหมู่ไฮดรอกซิล      
(-OH group) ส าหรับเอทิลแอลกอฮอล์มีสูตรโมเลกุลเป็น C2H5OH น ้ าหนกัโมเลกุลเท่ากบั 46 มีจุด
เดือดท่ีอุณหภูมิ 78.3 oC มีความถ่วงจ าเพาะเท่ากบั 0.79 ท่ีอุณหภูมิ 20 oC เป็นสารมีขั้วและละลายน ้ า
ไดดี้ มีลกัษณะเป็นของเหลวใส ไม่มีสี ระเหยไดง่้ายและติดไฟ ให้พลงังานประมาณ 7.1 แคลอรีต่อ
กรัม 

 

 

 

 

 

 

 

 



 

 

 

 

 

 

 

 

5 

 

เอทิลแอลกอฮอล์เม่ือรวมตวักบัสารโมเลกุลขนาดใหญ่ (Macromolecule) เช่น โปรตีนหรือ
โพลีแซคคาไรด์ จะท าให้สารโมเลกุลขนาดใหญ่ตกตะกอน แข็งตวัหรือเสียสภาพธรรมชาติ เพราะ
เกิดการดึงน ้ ามาไว้ในตัวแอลกอฮอล์อย่างมากมาย ขบวนการขจัดน ้ า (dehydration) น้ีท าให้
แอลกอฮอลถู์กน ามาใชเ้ป็นน ้ายาฆ่าเช้ือ (antiseptic) 
 

2.2.2   ความเข้มข้นของแอลกอฮอล์ในเคร่ืองดื่มชนิดต่าง ๆ 
ตารางท่ี 2-1   ปริมาณแอลกอฮอลใ์นเคร่ืองด่ืมชนิดต่าง ๆ 
---------------------------------------------------------------------------------------------------------------------- 
ชนิดเคร่ืองด่ืม  ปริมาณแอลกอฮอล ์(%)  ผลิตภณัฑจ์าก 
---------------------------------------------------------------------------------------------------------------------- 
เบียร์   10-15 (3.2-4.0)   เมล็ดพืชหรือขา้วมอลท ์
ไวน ์   15-20      ผลไม ้
บร่ันดี   45-60     กลัน่จากไวน์หรือผลไมอ่ื้น ๆ 
วสิก้ี   45-60    ขา้วบาร์เลย ์
วอดกา (Vodkas)   40-50    มนัฝร่ัง 
ยนิ (Gin)   40-48.5    กลัน่ผลิตภณัฑจ์ากพืช เช่น ลิโคริช 
รัม (Rum)   40-95    กลัน่กากน ้าตาล 
---------------------------------------------------------------------------------------------------------------------- 
 

การผลิตแอลกอฮอล์สามารถท าไดจ้ากการหมกัสารท่ีมีน ้ าตาลหรือแป้ง เคร่ืองด่ืมส่วนใหญ่ 
จะมีท่ีมา 3 ลกัษณะ คือ 

1.  เคร่ืองด่ืมท่ีไดจ้ากจากหมกัผลิตภณัฑท์างการเกษตร เช่น องุ่น และผลไมช้นิดต่าง ๆ   
2.  เคร่ืองด่ืมชนิดท่ีไดจ้ากการกลัน่ 
3.  เคร่ืองด่ืมผสมซ่ึงอาจจะไดจ้ากการหมกัและ/หรือ การกลัน่ร่วมกบัการใช้สารปรุงแต่ง 

(flavoring substance) 
 

 2.2.3   แอลกอฮอล์ในร่างกายมนุษย์ 
เอทานอลสามารถดูดซึมผ่านผนังกระเพาะ ล าไส้เขา้สู่ร่างกายไดโ้ดยตรง ไม่ตอ้งผ่านการ

ยอ่ยเลย โดยพบวา่ 95% ของท่ีด่ืมเขา้ไปถูกดูดซึมเขา้ผา่นกระเพาะอาหารและล าไส้เล็กส่วนตน้ เม่ือ
แอลกอฮอล์ถูกดูดซึมแล้ว จะกระจายไปทุกส่วนของร่างกาย มีประมาณ 5% ท่ีถูกขบัออกทางลม
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หายใจ ปัสสาวะ เหง่ือ ท่ีเหลือถูกท าลายท่ีตบั โดยเปล่ียนเป็นสารท่ีช่ือว่า อะเซททาลดีไฮด์ ก่อน 
แลว้เปล่ียนไปเป็นคาร์บอนไดออกไซด์และน ้ า ถึงแมว้่าเอทานอลจะสามารถรับประทานได ้แต่ถา้
รับเขา้สู่ร่างกายในปริมาณมากเกินไปก็มีโทษไดเ้ช่นกนั 

-  เม่ือด่ืมขนาดนอ้ยๆ ไม่เกิดอะไรกบัร่างกาย 
-  เม่ือด่ืมปริมาณพอสมควร ท าให้เกิดอาการผ่อนคลายกระตุ้นให้อยากอาหาร เคล้ิม 

           -  เม่ือด่ืมปริมาณมาก จะท าให้เกิดอาการง่วงซึม คล่ืนไส้ อาเจียน สูญเสียการทรงตัว
ประสาทมีการตอบโตช้า้มีการคาดคะเนและตดัสินใจผดิพลาด 

-  ถา้ไดรั้บเอทานอลในระยะยาว จะท าให้เป็นโรคพิษสุราเร้ือรังเกิดภาวะติดแอลกอฮอล์
และมีผลต่อระบบทางเดินอาหารและเน้ือเยือ่ตบั โดยท าใหเ้ป็นโรคตบัแขง็ 

- ในหญิงมีครรภอ์าจท าให้แทง้ หรือลูกผิดปกติทั้งร่างกายและสมองจะเห็นวา่พิษของเอทา
นอลมีความส าคญัมากเพราะนอกจากจะก่อให้เกิดผลร้ายแก่ผูด่ื้มเองแล้วยงัเป็นตวัก่อปัญหาใน
สังคมอีกดว้ย โดยเป็นเหตุใหเ้กิดอุบติัเหตุและคดีความต่างๆ มากข้ึน 

 
2.2.4   การวนิิจฉัยคนเมา 
ส าหรับการวนิิจฉยัคนเมา สามารถท าไดห้ลายวธีิ ดงัน้ี 
1.  วธีิทางกายภาพ (Physical method) มีวธีิทดสอบหลายแบบ ไดแ้ก่ 

1.1   ใหเ้ดินเป็นเส้นตรง ซ่ึงคนเมามกัจะเดินไม่เป็นเส้นตรง 
1.2   Finger to nose test ให้ผูท่ี้สงสัยวา่เมาหรือไม่หลบัตา เหยียดแขนออกไปทาง

ดา้นขา้ง แลว้ใหง้อแขนเอาปลายน้ิวมาจ้ีท่ีจมูกของตน คนเมาจะจ้ีไม่ถูก 
1.3   Finger to finger test ให้ผูท่ี้สงสัยว่าเมาหรือไม่ หลบัตากางแขนออกสองขา้ง 

แลว้ให้งอแขนเขา้มาพร้อมกนัชา้ ๆ โดยให้เอาปลายน้ิวช้ีมือขวาและมือ ซ้ายมาชนกนั คน
เมาจะท าเช่นน้ีไม่ได ้

 อย่างไรก็ตาม อาการแสดงดงักล่าว อาจจะพบไม่ครบทุกอย่าง เพราะการเกิดอาการข้ึนอยู่
กบัระดบัของการเมาและความคงทนฤทธ์ิของแอลกอฮอล์ของแต่ละคน และในทางปฏิบติัจริง ๆ 
แลว้คงจะไม่ตอ้งทดสอบตามวิธีขา้งตน้ แต่จะใช้การสังเกตและจดบนัทึกความผิดปกติท่ีพบ เช่น 
ลกัษณะการเดินมาหาเราไม่ตรง มีอาการเซ หรือขณะพูดคุยซกัประวติัจะไดก้ล่ินแอลกอฮอลจ์ากลม
หายใจ หรือขณะเซ็นต์ช่ือพบมีอาการมือสั่น เป็นตน้ ซ่ึงคงจะตอ้งตรวจทางห้องปฏิบติัการยืนยนั
ต่อไป 
 2.  วธีิทางเคมี (Chemical method) เป็นการตรวจทางหอ้งปฏิบติัการโดยใชป้ฏิกิริยาเคมี เพื่อ
หาปริมาณแอลกอฮอลใ์นส่ิงส่งตรวจชนิดต่าง ๆ ไดแ้ก่ เลือด ปัสสาวะ สมอง ของเหลวในกระเพาะ
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อาหาร น ้ าไขสันหลงั ฯลฯ  ซ่ึงหลกัการตรวจก็คือ แอลกอฮอล์ซ่ึงมีคุณสมบติัเป็น reducing agent 
สามารถไปออกซิไดซ์โครเมียมอิออนท่ีมีประจุ 6+ เปล่ียนเป็นโครเมียมอิออนประจุ 3+ (สีเขียว)  ใน
สารละลายท่ีเป็นกรด จากนั้นน ามาวดัสีท่ีเปล่ียนไปโดยใชเ้คร่ืองสเปคโตรโฟโตมิเตอร์ และสามารถ
ค านวณหาปริมาณแอลกอฮอล์ได้ โดยเทียบค่าการดูดกลืนแสงกบัของสาร (แอลกอฮอล์) มาตรฐาน
ท่ีรู้ความเขม้ขน้ 
 วิธีน้ีนับว่าเป็นวิธีท่ีประหยดัค่าใช้จ่าย ตามห้องปฏิบัติการโรงพยาบาลชุมชนทั่วไปก็
สามารถท าการตรวจวดัได้ เพราะจะมีสเปคโตรโฟโตมิเตอร์อยู่แล้ว แต่ก็ยงัมีข้อเสียคือ สาร 
Reducing agent อ่ืน ๆ เช่น เมธานอล คีโตน อลัดีไฮด์ สามารถท าปฏิกิริยากบัน ้ ายาน้ีได้ จะท าให้
แปรผลผิดพลาดได้ อย่างไรก็ตามสารเหล่าน้ีก็พบได้ไม่บ่อยในส่ิงส่งตรวจทั่วไป ส าหรับการ
ตรวจสอบท่ีใชห้ลกัการน้ีและใชแ้พร่หลายคือวธีิของ Widmark และวธีิของ Conway 

3.  วิธีทางชีวเคมี (Biochemical methods) เป็นการตรวจหาปริมาณแอลกอฮอล์โดยใช้
เอ็นไซม์ Alcohol dehydrogenase (ADH) ซ่ึงเอ็นไซม์ตวัน้ีจะเปล่ียนแอลกอฮอล์เป็นอะเซตลัดีไฮด์
โดยมีโคเอน็ไซม์ คือ NAD (Nicotinamide adenine dinucleotide) ซ่ึงจะถูกเปล่ียนเป็น NADH ต่อไป 
ส าหรับ NADH สามารถน ามาวดัดว้ยเคร่ืองสเปคโตรโฟโตมิเตอร์ท่ีความยาวคล่ืน 340 นาโนเมตร 
 ขอ้ไดเ้ปรียบของวิธีน้ีคือ ง่ายและไม่ตอ้งใช้เคร่ืองมือพิเศษอะไรโดยเฉพาะเอ็นไซม์ ADH 
ไม่ท าปฏิกิริยากบัเมธิลแอลกอฮอลห์รืออะซีโตน แต่สามารถท าปฏิกิริยาไดเ้ล็กนอ้ยกบัไอโซโพรพิล
แอลกอฮอล ์และบิวทิลแอลกอฮอล์ 

4.  วิ ธีแก๊สโครมาโตกราฟฟ่ี  (Gas chromatographic method) นับเป็นวิธี ท่ี นิยมสูงสุด
ส าหรับการตรวจหาแอลกอฮอล์ในทางนิติเวชศาสตร์ มีหลายเทคนิคส าหรับการตรวจดว้ยเคร่ือง
แก๊สโครมาโตกราฟฟ่ี เช่น การสกดั การตกตะกอนโปรตีน การกลัน่ การฉีดเขา้เคร่ืองโดยตรง หรือ
การใชเ้ทคนิค head space 
   ข้อดีของวิธีน้ีคือ ไม่มีสารท่ีจะรบกวนการตรวจวดั ถือเป็นวิธีอ้างอิงของการตรวจวดั
แอลกอฮอล ์แต่ตอ้งใชอุ้ปกรณ์ท่ีมีราคาค่อนขา้งแพงคือ เคร่ืองแก๊สโครมาโตกราฟฟ่ี 

5.  วธีิเป่าลมหายใจ (Breathalyzer method) การใชเ้คร่ืองตรวจวดัแอลกอฮอล์ดว้ยวธีิเป่าลม
หายใจ เร่ิมมีการใช้หลงัจากมีการออกกฎหมายเก่ียวกบัการตรวจจบัผูข้บัข่ียานพาหนะขณะเมาสุรา 
นบัเป็นวิธีท่ีสะดวกในการปฏิบติังานภาคสนาม เช่น การตั้งด่านตรวจจบั สามารถให้ผลไดร้วดเร็ว 
ส าหรับหลกัการท่ีใช้ในการตรวจวดัดว้ยวิธีน้ี มีทั้งการใช้วิธีทางเคมี และวิธีแก๊สโครมาโตกราฟฟ่ี 
นอกจากน้ีก็มีการใช้หลกัการของ Infrared absorption หลงัจากตรวจวดัจากลมหายใจก็ตอ้งมีการ
ค านวณกลบัไปเป็นระดบัแอลกอฮอล์ในเลือดโดยน าตวัเลข 2,100 มาคูณค่าท่ีได ้  เน่ืองจากสัดส่วน
ของแอลกอฮอล์ในลมหายใจต่อเลือดนั้ นเฉล่ียกับ 1 : 2,100 (alveolar air : arterial blood) แต่ใน
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ปัจจุบนัเคร่ืองตรวจวดัแอลกอฮอล์จากลมหายใจส่วนใหญ่จะค านวณออกมาเป็นระดบัแอลกอฮอล์
ในเลือดจากเคร่ืองโดยตรงนบัวา่สะดวกมาก 

 
2.2.5   แอลกอฮอล์กบัอุบัติเหตุจราจร 
การเกิดอุบัติเหตุทางจราจรเป็นปัญหาใหญ่ของทุกเมือง โดยเฉพาะอย่างยิ่งเมืองท่ีมี

การจราจรหนาแน่น ปัญหาเหล่าน้ีอาจเน่ืองมาจากการเพิ่มปริมาณของยานพาหนะ สภาพถนน 
สภาพของยานพาหนะและทีส าคัญคือ บุคคลท่ีใช้รถใช้ถนนมีการเสพสุราหรือเคร่ืองด่ืมท่ีมี
ส่วนผสมของแอลกอฮอล์ จากการาตรวจศพท่ีภาควิชานิติเวชศาสตร์ คณะแพทยศาสตร์ ศิริราช
พยาบาลพบวา่ประมาณ 33% ของคนท่ีตายจากอุบติัเหตุจราจรมีแอลกอฮอลใ์นเลือด 

ฤทธ์ิของแอลกอฮอลต่์อความสามารถในการขบัรถ มีดงัน้ี 
1. ท าให้ เผลอตัวง่าย ไม่มีสมาธิท่ีจะระมัดระวงัในการขับรถ คนด่ืมสุราท่ีมีปริมาณ

แอลกอฮอล์ในเลือดตั้งแต่ 20 มิลลิกรัมเปอร์เซ็นต์ มกัจะขาดความระมดัระวงัในการขบัรถ เช่น คุย
เพลิน มองเพลิน ส าหรับคนท่ีมีแอลกอฮอลใ์นเลือด 80 มิลลิกรัมเปอร์เซ็นต์ จะมีผลต่อการสังเกตวา่
รถยนตท่ี์อยูข่า้งหนา้นั้นจอดอยูห่รือก าลงัแล่นเหล่าน้ี จะเป็นเหตุใหเ้กิดอุบติัเหตุไดง่้าย 

2. การตดัสินใจผิดพลาด ตามธรรมดาการขบัรถตอ้งการตดัสินใจรีบด่วนท่ีจะแก้ปัญหา
เฉพาะหนา้ เช่น กรณีมีรถจอดขวางหนา้ในระยะกระชั้นชิดก็ตอ้งตดัสินใจวา่ ถา้หลบพน้ก็หลบหรือ
ถา้หา้มลอ้ทนัก็หา้มลอ้ คนท่ีเมาสุรานั้นมกัตดัสินใจผดิพลาด 

3. มีผลต่อระยะเวลาการตัดสินใจ ซ่ึงระยะเวลาการตัดสินใจ (reaction time) หมายถึง 
ระยะเวลาสมองสั่งงานจนถึงเวลาท่ีร่างกายท าตามท่ีสมองสั่ง เช่น เวลาขบัรถผา่นไฟ เม่ือตาเห็นไฟ
แดงแลว้สมองสั่งงานให้เทา้เหยียบเบรค ระยะเวลาท่ีสมองสั่งจนถึงระยะเวลาท่ีเทา้แตะเบรคเป็น
ระยะเวลาตดัสินใจ ซ่ึงมีค่าเฉล่ียเท่ากนั 0.75 วินาที ส าหรับคนท่ีเมาสุราจะมีระยะเวลาการตดัสินใจ
นานกวา่คนปกติ 

4. การเคล่ือนไหวของร่างกายเป็นไปไม่ดี คนเมาท่ีมีปริมาณแอลกอฮอล์ในเลือดตั้งแต่ 90 
มิลลิกรัมเปอร์เซ็นต ์การควบคุมการเคล่ือนไหวของแขนและขาเป็นไปไม่ไดต้ามปกติ 

5.  การไดย้นิและการเห็นมีความผดิปกติ ดงัน้ี 
5.1 การปรับม่านตาในความมืดจะกินเวลานานกวา่ปกติ 
5.2 การปรับภาพจากลูกตาทั้งสองถูกรบกวนเม่ือมีปริมาณแอลกอฮอล์ในเลือด

ตั้งแต่ 50 มิลลิกรัมเปอร์เซ็นต์ ข้ึนไป ซ่ึงหมายถึง อาจท าให้เห็นภาพเป็นสอง
ภาพหรือเป็นภาพเดียวแต่ไม่ชดั 
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5.3 การกะระยะความลึกผิดไป  เม่ือมีปริมาณแอลกอฮอล์ในเลือดตั้ งแต่ 30 
มิลลิกรัมเปอร์เซ็นต ์ข้ึนไป 

5.4 การเห็นแสงไฟท่ีเคล่ือนไหวน้อยลง พบได้เม่ือปริมาณแอลกอฮอล์ในเลือด
ตั้งแต่ 20 มิลลิกรัมเปอร์เซ็นต ์

5.5 ความรู้สึกสัมผสัของผิวหนงัชา้ เม่ือขบัรถเร็วก็ไม่ค่อยรู้สึกการเสียดสีของลมท่ี
ผวิหนงั 

5.6 หูอ้ือ  คนเมาจึงตอ้งพดูเสียงดงั ขณะขบัรถการไดย้นิเสียงรถคนัอ่ืนจึงไม่ดี 
 

2.2.6   ระดับความเข้มข้นของแอลกอฮอล์ในเลือดที่ถือว่าผิดกฎหมาย (Blood alcohol 
concentration as a constituent of the offence) 

ในปี ค.ศ. 1967 ท่ีประชุมเก่ียวกบัการขนส่งของยุโรปได้เสนอค่าสูงสุดของความเขม้ขน้
ของแอลกอฮอล์ในเลือดท่ีกฎหมายยอมให้ผูข้บัข่ียานพาหนะมีได ้โดยยงัไม่มีความผิด ค่าดงักล่าว
เท่ากับ 80 มิลลิกรัมเปอร์เซ็นต์  ประเทศสมาชิกต่าง ๆ ได้คล้อยตามโดยก าหนดเป็นมาตรฐาน
เดียวกัน ซ่ึงประเทศเหล่านั้นได้แก่ ออสเตรีย  สวิตเซอร์แลนด์ องักฤษ ฮอลแลนด์  ฝร่ังเศสและ
เยอรมนั เป็นตน้ ส าหรับสหรัฐอเมริกา เดิม State Model Vehicle Law ให้ความเห็นว่าบุคคลจะอยู่
ภายใตอิ้ทธิพลของแอลกอฮอล์เม่ือระดบัความเขม้ขน้ของแอลกอฮอล์ในเลือดเกิน 150 มิลลิกรัม
เปอร์เซ็นต ์แต่ถา้ระดบัความเขม้ขน้ของแอลกอฮอลใ์นเลือดต ่ากวา่ 50 มิลลิกรัมเปอร์เซ็นต ์ถือวา่ไม่
อยูใ่ตอิ้ทธิพลของแอลกอฮอล์ ส าหรับความเขม้ขน้ของแอลกอฮอล์ระหวา่ง 50 มิลลิกรัมเปอร์เซ็นต ์
ถึง 150 มิลลิกรัมเปอร์เซ็นต์ ให้ตดัสินโดยถืออาการของผูถู้กตรวจร่วมด้วย ต่อมาในปี ค.ศ. 1972  
National Highway Traffic Safety Administration ได้แน ะน าให้ ถื อ ระดับ ความ เข้ม ข้น ขอ ง
แอลกอฮอล์ในเลือดท่ีไม่อนุญาตให้ขบัข่ียานพาหนะเม่ือเกิน 100 มิลลิกรัมเปอร์เซ็นต์ ผลจากการ
แนะน าน้ีเป็นเหตุให้รัฐต่าง ๆ ในสหรัฐอเมริกาก าหนดขอบเขตความเขม้ขน้ของแอลกอฮอลใ์นเลือด 
ท่ียงัยนิยอมใหข้บัข่ียานพาหนะไดแ้ตกต่างกนั ดงัน้ี คือ  

จ  านวน 32 รัฐ ก าหนดความเขม้ขน้ของแอลกอฮอลใ์นเลือด 100 มิลลิกรัมเปอร์เซ็นต ์
จ านวน  9 รัฐ ก าหนดความเขม้ขน้ของแอลกอฮอลใ์นเลือด 150 มิลลิกรัมเปอร์เซ็นต ์
จ านวน  2 รัฐ ก าหนดความเขม้ขน้ของแอลกอฮอลใ์นเลือด 80 มิลลิกรัมเปอร์เซ็นต ์

 ประเทศออสเตรเลีย ถือระดบัความเขม้ขน้ของแอลกอฮอล์ในเลือดท่ียงัยินยอมให้ขบัข่ี
ยานพาหนะไดเ้ท่ากบั 80 มิลลิกรัมเปอร์เซ็นต ์ยกเวน้รัฐวคิตอเรีย ก าหนดใช ้50 มิลลิกรัมเปอร์เซ็นต ์
 ประเทศนิวซีแลนด์ ถือระดับความเขม้ข้นของแอลกอฮอล์ในเลือดท่ียงัยินยอมให้ขบัข่ี
ยานพาหนะไดเ้ท่ากบั 100 มิลลิกรัมเปอร์เซ็นต ์
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 ประเทศสาธารณเชค โปแลนด์ ก าหนดความเขม้ขน้ของแอลกอฮอลใ์นเลือดท่ียงัยนิยอมให้
ขบัข่ียานพาหนะไดต้ ่ากวา่ประเทศอ่ืน ๆ โดยก าหนดไวเ้พียง 30 มิลลิกรัมเปอร์เซ็นต ์
 ส าหรับประเทศไทย ไดมี้พระราชบญัญติัจราจรทางบก พ.ศ. 2522 มาตรา 43 โดยบญัญติั
เก่ียวกบัเร่ืองเมาสุราไวด้งัน้ี “หา้มมิใหผู้ข้บัข่ีรถ 

1.  ในขณะหยอ่นความสามารถในอนัท่ีจะขบั 
2.  ในขณะเมาสุราหรือของเมาอยา่งอ่ืน 
3.  ฯลฯ” 
มาตรา 157 ผู ้ใดฝ่าฝืนไม่ปฏิบัติตามมาตรา…….., มาตรา 43,……… ต้องระวางโทษ

ปรับตั้งแต่ส่ีร้อยบาทถึงหน่ึงพนับาท 
ซ่ึงจากบทบัญญัติแห่งมาตรา 43 น้ียงัไม่มีการระบุช้ีชัดลงไปว่าระดบัความเข้มข้นของ

แอลกอฮอลใ์นเลือดเป็นเท่าใดจึงจะถือวา่เมา จึงไดมี้การออกกฎกระทรวง เม่ือปี 2537  ดงัน้ี 
 

กฎกระทรวง 
ฉบับที ่16 (พ.ศ. 2537) 

ออกตามความในพระราชบัญญตัิจราจรทางบก 
พ.ศ. 2522 

-------------------- 
 อาศยัอ านาจตามความในมาตรา 5 แห่งพระราชบญัญติัจราจรทางบก พ.ศ. 2522  และมาตรา 
142  วรรคสาม  แห่งพระราชบญัญติัจราจรทางบก  พ.ศ. 2522  ซ่ึงแกไ้ขเพิ่มเติมโดยพระราชบญัญติั
จราจรทางบก (ฉบับท่ี 4)  พ.ศ. 2535  รัฐมนตรีว่าการกระทรวงมหาดไทยออกกฎกระทรวงไว้
ดงัต่อไปน้ี 
 ข้อ 1 การทดสอบผูข้บัข่ีวา่เมาสุราหรือไม่ ให้ตรวจวดัปริมาณแอลกอฮอลใ์นเลือดของผูข้บั
ข่ี โดยใชว้ธีิการตามล าดบั ดงัต่อไปน้ี 
 (1)  ตรวจวดัลมหายใจด้วยเคร่ืองมือและอุปกรณ์ท่ีใช้ในการตรวจหรือทดสอบ  ให้ใช้
เคร่ืองตรวจวดัระดับแอลกอฮอล์ในเลือด โดยวิธีเป่าลมหายใจ (BREATH ANALYZER TEST) 
และอ่านค่าของแอลกอฮอลใ์นเลือดเป็นมิลลิกรัมเปอร์เซ็นต ์
 วธีิการตรวจหรือทดสอบใหป้ฏิบติัตามวิธีการตรวจสอบของเคร่ืองตรวจแต่ละชนิด 

(2) ตรวจวดัจากปัสสาวะ 
(3) ตรวจวดัจากเลือด 
การตรวจวดัตาม (2) หรือ (3) ใหใ้ชใ้นกรณีท่ีไม่สามารถทดสอบตาม (1) ไดเ้ท่านั้น 
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 ข้อ 2.   กรณีท่ีต้องทดสอบโดยวิธีตรวจวดัจากเลือดตามข้อ  1(3) ให้ส่งตัวผูข้ ับข่ีไปยงั
โรงพยาบาลท่ีใกลท่ี้สุด และท าการเจาะเลือดภายใตก้ารก ากบัดูแลของผูป้ระกอบวิชาชีพเวชกรรม
ตามกฎหมายวา่ดว้ยวชิาชีพเวชกรรม 

ข้อ 3. ถา้มีปริมาณแอลกอฮอลใ์นเลือดดงัต่อไปน้ีใหถื้อวา่เมาสุรา 
(1) กรณีตรวจวดัจากเลือดเกิน 50 มิลลิกรัมเปอร์เซ็นต ์ 

  (2) กรณีตรวจวดัจากลมหายใจหรือปัสสาวะ ให้เทียบปริมาณแอลกอฮอล์ โดยใช้
ปริมาณแอลกอฮอลใ์นเลือดเป็นเกณฑม์าตรฐานดงัน้ี 
  (ก)  กรณีตรวจวดัจากลมหายใจ ใหใ้ชค้่าสัมประสิทธ์ิในการแปลงค่าเท่ากบั 2,000 
  (ข)  กรณีตรวจวดัจากปัสสาวะ ให้ใช้ค่าสัมประสิทธ์ิในการแปลงค่าเท่ากบัเศษ 1 
ส่วน 1.3 

ใหไ้ว ้ณ วนัท่ี 15 พฤศจิกายน พ.ศ. 2537 
 

พลเอก ชวลิต  ยงใจยทุธ 
(ชวลิต  ยงใจยทุธ) 

รัฐมนตรีวา่การกระทรวงมหาดไทย 
 
 จากกฎกระทรวงฉบบัน้ีก็สรุปไดว้า่ความเขม้ขน้ของแอลกอฮอล์ในเลือดท่ียินยอมให้ขบัข่ี
ยานพาหนะไดต้อ้งไม่เกิน 50 มิลลิกรัมเปอร์เซ็นต ์
 

2.3   การตรวจวดัแอลกอฮอล์ในร่างกาย 
 การศึกษาวิธีท่ีจะวดัระดบัแอลกอฮอล์ในร่างกายมีมากวา่ 150 ปีแลว้ ผูท่ี้ศึกษาเป็นคนแรก
คือ Francis Edmund Anstie (ค.ศ. 1833 - ค.ศ. 1874) ชาวองักฤษ พบวา่ แอลกอฮอล์ท่ีด่ืมเขา้ไป จะ
สามารถพบบางส่วนไดใ้นลมหายใจ และปัสสาวะ นกัวิทยาศาสตร์ชาวฝร่ังเศส ช่ือ Nielous (ค.ศ. 
1848 - ค.ศ. 1910) ศึกษาพบว่า แอลกอฮอล์ท่ีด่ืมเขา้ไป จะพบในลมหายใจ ปัสสาวะ น ้ าลาย และ
เหง่ือ หลงัจากนั้นไดมี้นกัวทิยาศาสตร์ท าการศึกษาวจิยัอีกหลายท่าน 

ในระยะแรกการวิเคราะห์หาปริมาณแอลกอฮอล์ใชว้ิธีเก็บ ตวัอยา่งจากเลือด หรือ ปัสสาวะ
จากผูต้อ้งสงสัย แต่มีปัญหาคือ ตอ้งวิเคราะห์ในห้องปฏิบติัการและตอ้งใชผู้ท่ี้มีความช านาญ ทราบ
ผลช้า และท่ีส าคญัคือ ไม่สามารถส่ือไปถึงปริมาณแอลกอฮอล์ในเลือดไดอ้ยา่งแทจ้ริง ทั้งน้ีข้ึนอยู่
กบัปริมาณน ้ าในร่างกาย ฉะนั้น ได้มีการน าวิธีการวิเคราะห์ปริมาณแอลกอฮอล์ในเลือดจากลม
หายใจมาใช้ ในช่วงปี 1930-1953 ไดมี้การคิดคน้เคร่ืองวดัแอลกอฮอล์ในเลือดโดยวิธีเป่าลมหายใจ

 

 

 

 

 

 

 

 



 

 

 

 

 

 

 

 

12 

 

ข้ึน และไดมี้การพฒันาเคร่ืองมือวดัเป็นรุ่น ๆ จนถึงปัจจุบนั การพฒันาเคร่ืองวดัน้ี เพื่อออกแบบให้
เคร่ืองสามารถวดัได้เฉพาะแอลกอฮอล์ชนิดท่ีเป็น Ethyl อย่างเดียว (เคร่ืองด่ืมผสมแอลกอฮอล์ท่ี
มนุษย์เราด่ืมจะผสมแอลกอฮอล์ชนิด Ethyl) โดยไม่ ถูกสอดแทรกโดยสารอ่ืน เช่น acetone, 
chloroform, ether, ethyl acetate, methanol เป็นตน้ เพื่อท่ีจะให้การวิเคราะห์ปริมาณลมหายใจใกล้
กบัปริมาณแอลกอฮอลใ์นเลือดมาก ท่ีสุด 

 
2.3.1   เคร่ืองวดัระดับแอลกอฮอล์ด้วยลมหายใจ 
เคร่ืองวดัระดบัแอลกอฮอล์ในเลือดโดยวธีิเป่าลมหายใจ แบ่งตามลกัษณะของเคร่ืองไดเ้ป็น

สองประเภท คือแบบพกพา (Mobile) และแบบประจ าท่ี (Stationary) ถา้แบ่งตามวตัถุประสงค์การ
ใชง้าน แบ่งไดเ้ป็น 2 ชนิด คือ เคร่ืองวดัระดบัแอลกอฮอล์ในเลือดโดยวธีิเป่าลมหายใจแบบตรวจคดั
กรอง (screening) และเคร่ืองวดัระดบัแอลกอฮอล์ในเลือดโดยวิธีเป่าลมหายใจแบบตรวจยืนยนัผล 
(Evidential) 

โดยท่ีเคร่ืองวดัระดับแอลกอฮอล์ในเลือดโดยวิธีเป่าลมหายใจ แบบตรวจคดักรอง เป็น
เคร่ืองท่ีใชใ้นการทดสอบปริมาณแอลกอฮอล์ในเลือด โดยวิธีเป่าลมหายใจเขา้เคร่ืองวดั ผลท่ีแสดง
จะเป็นตวัหนังสือว่าเกิน หรือไม่เกินค่ามาตรฐานท่ีตั้งไว ้เช่น แสดงเป็น pass หรือ Fail หรืออาจ
แสดงเป็นตวัเลขก็ได ้

เคร่ืองวดัระดับแอลกอฮอล์แบบตรวจยืนยนัผล เป็นเคร่ืองท่ีใช้ในการตรวจวดัปริมาณ
แอลกอฮอล์ในเลือด โดยวิธีเป่าลมหายใจเขา้เคร่ืองวดั ผลท่ีได้จะแสดงเป็นตวัเลขว่ามีปริมาณใน
หน่วย mg/100ml เช่น 50 mg/100ml (แสดงว่า ในเลือด 100 มิลลิลิตรมีปริมาณแอลกอฮอล์อยู่ 50 
มิลลิกรัม) เป็นตน้ 

 
 2.3.2   การท างานของเคร่ืองวดัระดับแอลกอฮอล์ด้วยลมหายใจ 

ส าหรับการท างานของเคร่ืองวดัระดบัแอลกอฮอล์ในเลือดโดยวิธีเป่าลมหายใจนั้น ในการ
ตรวจจะให้ผู ้ตรวจเป่าลมหายใจเข้าเคร่ืองซ่ึงมีตัวตรวจจับแอลกอฮอล์ (Alcohol Detector) ตัว
ตรวจจับเม่ือได้รับแอลกอฮอล์จากลมหายใจ จะมีการแปรสภาพซ่ึงอาจมองเห็นได้ เช่นการ
เปล่ียนแปลงสีของสารเคมี หรือว ัดได้จากพลังงาน เช่น กระแสไฟฟ้า ความต่างศักย์ การ
เปล่ียนแปลงสภาพน้ี จะถูกแปลค่าให้รายงานออกมาท่ีหน้าปัดของเคร่ือง ในของ ปริมาณ
แอลกอฮอล์ในเลือด (Blood Alcohol Concentration: BAC) ทั้งน้ี โดยอาศยัการค านวณค่าจาก ค่า
ความสัมพนัธ์ของสัมประสิทธ์ิในการแปลงค่าปริมาณแอลกอฮอล์ในเลือดเป็น ปริมาณแอลกอฮอล์
ในลมหายใจ 
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การท่ีเคร่ืองวดัระดับแอลกอฮอล์ในเลือดโดยวิธี เป่าลมหายใจ จะวิเคราะห์ปริมาณ
แอลกอฮอล์ในเลือดจากลมหายใจไดถู้กตอ้ง ตอ้งใชล้มหายใจจากส่วนลึกของปอดท่ีสัมผสักบัเส้น
เลือดฝอยในปอด เพื่อจะให้ไดค้่าปริมาณแอลกอฮอล์ท่ีถูกตอ้ง ผูผ้ลิตไดอ้อกแบบให้เคร่ืองวดัฯ เม่ือ
ถูกเป่าลมหายใจเขา้เคร่ืองต่อเน่ืองไปไดร้ะยะหน่ึง ความแรงในการเป่าจะลดลง สูบไฟฟ้าในเคร่ืองฯ 
จะเก็บตวัอย่างลมหายใจประมาณ 1 ซีซี แบบอตัโนมติั ในกรณีท่ีเคร่ืองไม่ได้ออกแบบให้เก็บ
ตวัอยา่งลมหายใจแบบอตัโนมติั การตรวจวดัตอ้งให้ผูถู้กตรวจเป่าลมหายใจเขา้เคร่ืองอยา่งต่อเน่ือง 
และผูท่ี้ท  าการตรวจวดั จะนบั 1 ถึง 5 ในใจอย่างช้าๆ เม่ือนบัครบแลว้ จึงกดปุ่มรับตวัอยา่ง เพื่อให้
สูบไฟฟ้าเก็บตวัอยา่ง รูปท่ี 1 แสดงถึงความสัมพนัธ์ของระดบัแอลกอฮอล์ในลมหายใจกบัปริมาตร
ของลมหายใจท่ีเป่าออกมา จะเห็นวา่เม่ือเป่าลมหายใจเขา้เคร่ืองวดั ความเขม้ขน้ของแอลกอฮอล์ใน
ลมหายใจจะเร่ิมตน้ท่ีจุดๆ หน่ึง แลว้ค่อยๆ เพิ่มข้ึน และความเขม้ขน้จะค่อยๆ คงท่ีในท่ีสุด 

 

 
รูปท่ี 2-1   กราฟแสดงความสัมพนัธ์ของระดบัแอลกอฮอลใ์นลมหายใจกบัปริมาตรของลม

หายใจท่ีเป่าออกมา 
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2.3.3   ตัวอย่างตัวตรวจจับแอลกอฮอล์แบบต่างๆ 
มีดว้ยกนั 4 แบบคือ  

1. แบบ Colorimeter ใช้หลกัการเปล่ียนสีของ Potassium Dichromate จากสีเหลือง 
ถา้ไดรั้บไอของแอลกอฮอล ์จะเปล่ียนเป็นสีเขียว 

ข้อเปรียบเทียบ ใชท้ดสอบแอลกอฮอลใ์นลมหายใจ ใชไ้ดค้ร้ังเดียว 
2. แบบ Semiconductor ใช้หลกัการไอของแอลกอฮอล์ไปจบั Semi-conductor ท า

ใหค้วามตา้นทานเปล่ียนแปลง 
ข้อเปรียบเทียบ ใชท้ดสอบแอลกอฮอลใ์นลมหายใจ แต่ความเท่ียงตรงไม่ดี 
3. แบบ Fuel cell เป็นแบบเซลลไ์ฟฟ้าเคมี (Electrochemical Fuel cell) เม่ือไอของ 

แอลกอฮอล์ถูกดูดซับโดย cell จะท าให้เกิดปฏิกิริยากลายเป็นกรดอะเซติคและเกิด
กระแสไฟฟ้าซ่ึงเป็นสัดส่วน โดยตรงกบัปริมาณแอลกอฮอล ์

ข้อเปรียบเทียบ มีความถูกตอ้งดี มีความจ าเพาะต่อการวดั Ethyl alcohol เคร่ืองมี 
ขนาดเล็กพกพาได้ ราคา 42,600 บาท เม่ือปี2547 (ครม.อนุมติัจดัซ้ือ ให้ศูนยอ์  านวยการ
ความปลอดภยัทางถนน) 

4. แบบ Infrared Absorption อาศยัหลกัการท่ีแสง Infrared จะถูกดูดซับมากน้อย
เท่าใดข้ึนกบัระดบัความเขม้ขน้ของไอแอลกอฮอล ์

ข้อเปรียบเทียบ มีความถูกตอ้งดี มีความจ าเพาะต่อการวดั Ethyl alcohol แต่เคร่ืองมี
ขนาดใหญ่ราคาสูงเหมาะใชส้ าหรับใชป้ระจ าท่ี 

  
 

2.3.4   ผลของแอลกอฮอล์ในเลอืดทีร่ะดับความเข้มข้นต่างๆ ต่อร่างกายและจิตใจ 
ตารางท่ี 2-2   แสดงผลของแอลกอฮอล์ในเลือดท่ีระดบัความเขม้ขน้ต่างๆ ต่อร่างกายและ

จิตใจ 

ความเขม้ขน้ของแอลกอฮอลใ์นเลือด 
(มิลลิกรัม/ 100 มิลลิลิตร) 

ผลต่อร่างกายและจิตใจ 

20 – 30 ไม่ปรากฏอาการผิดปกติใดๆ นอกจากผู ้ด่ืมมี
อาการแจ่มใสเมข้ึน 

50 – 60 มีความรู้สึกผ่อนคลายทางอารมณ์ ประสาทและ
กล้ามเน้ือลดความว่องไวลง ระยะเวลาในการ
ต อ บ ส น อ ง ย า ว ข้ึ น  ก า ร ตั ด สิ น ใ จ ช้ า ล ง 
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ความสามารถในการขบัข่ียานยนตล์ดลง เป็นระดบั
ความเขม้ข้นท่ีถือว่าผูข้บัข่ีตกอยู่ในอาการมึนเมา 
(ส าหรับประเทศไทย) 

80 – 100 เร่ิมเสียการทรงตวั พูดไม่ชดั สายตาแยล่ง มองเห็น
ไม่ ชัด  เร่ิม มี ปั ญห าเก่ี ยวกับก ารได้ยิน  รู้ สึ ก
เคลิบเคล้ิม มีความเช่ือมัน่เพิ่มข้ึน กลา้มเน้ือท างาน
ไม่ ป ระส านกัน  ท าให้ ล าบ าก ในการบังคับ
ยานพาหนะ 

110 – 120 การเคล่ือนไหวและการทรงตัวท าได้ด้วยความ
ยากล าบ าก  ความสามารถท างความ คิดการ
ตดัสินใจและการใชว้ิจารณญาณเส่ือมลงอยา่งเห็น
ไดช้ดั 

140 – 150 การควบคุมร่างกายและจิตใจส่วนใหญ่เสียไป พูด
ไม่ชดั มองเห็นภาพเลือนราง ไม่ชดัเจน มีอุปสรรค
ในการใชมื้อ แขนและขา 

200 สูญ เสียการควบคุมการท างานของกล้าม เน้ือ 
ต้องการความช่วยเหลือเม่ือจะเคล่ือนไหว จิตใจ
สับสนอยา่งเห็นไดช้ดั 

300 มีอาการมึน เมาอย่างหนัก  มึนงง ไม่ รู้ เร่ือง มี
สติสัมปชญัญะเหลืออยูน่อ้ยมาก 

400 สลบ หมดสติ ไม่รู้สึกตวั 
500 สลบลึก 
600 เสียชีวติเน่ืองจากการหายใจลม้เหลว 
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2.3.5   ความสัมพันธ์ระหว่างระดับความเข้มข้นของแอลกอฮอล์ในเลือดกับโอกาสเกิด
อุบัติเหตุจราจร 

ตารางท่ี 2-3   ตารางแสดงความสัมพนัธ์ระหวา่งระดบัความเขม้ขน้ของแอลกอฮอลใ์นเลือด
กบัโอกาสเกิดอุบติัเหตุจราจร 

 
 

 

ระดับแอลกอฮอล์
ในเลือด 
( มิ ล ลิ ก รั ม
เปอร์เซ็นต)์ 

สมรรถภาพในการขบัข่ีรถ โอก าส เกิ ด อุบั ติ เห ตุท าง
จราจร 

20 มีผลเพียงเล็กนอ้ยเฉพาะบางคน ใกลเ้คียงกบัคนไม่ด่ืมสุรา 
50 มีผลท าให้ความสามารถในการขบั

รถลดล งเฉ ล่ี ย  8% เป็ น ระดับ ท่ี
นกัวิจยัทัว่ไปยอมรับวา่การขบัรถจะ
เป็นอนัตราย 

โอกาสเกิดอุบัติ เห ตุ เป็น  2 
เท่าของคนท่ีไม่ด่ืมสุรา 

80 มีผลท าให้ความสามารถในการขบั
รถลดลงเฉ ล่ีย 12% และมีผลต่อ
คนขบัรถทุกคน และระดบัน้ีใช้เป็น
กฎหมายควบคุมในหลายประเทศ 

โอกาสเกิดอุบัติ เห ตุ เป็น  3 
เท่าของคนท่ีไม่ด่ืมสุรา 

100 มีผลท าให้ความสามารถในการขบั
ร ถ ล ด ล ง เฉ ล่ี ย  15% มี ผ ล ต่ อ
คนขบัรถทุกคนและการขบัรถจะแย่
ลงอยา่งรวดเร็วเม่ือถึงระดบัน้ี 

โอกาสเกิดอุบัติ เห ตุ เป็น  6 
เท่าของคนท่ีไม่ด่ืมสุรา 

150 มีผลท าให้ความสามรถในการขบัรถ
ลดลงเฉล่ีย 33% 

โอกาสเกิดอุบัติเหตุเป็น 40 
เท่าของคนท่ีไม่ด่ืมสุรา 

มากกวา่ 200 สมรรถภาพลดลงเป็นสัดส่วนกับ
ระดบัแอลกอฮอล ์

ไม่สามารถวดัได้ เน่ืองจาก
ควบคุมการทดลองไม่ได ้แต่
โอกาสเกิดอุบติัเหตุสูงมาก 
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2.4   เคร่ืองตรวจวดัระดับแอลกอฮอล์ด้วยลมหายใจแบบ Semiconductor 
 เม่ือเราด่ืมเคร่ืองด่ืมท่ีมีแอลกอฮอล์ แอลกอฮอล์ก็จะเขา้ไปในกระแสเลือด และเม่ือกระแส
เลือดไหลไปท่ีปอดเพื่อแลกเปล่ียนก๊าซออกซิเจน และคาร์บอนไดออกไซด์ เขา้ออกจากร่างกาย 
แอลกอฮอล์ในกระแสเลือดบางส่วนจะผา่นออกจากปอดดว้ย ซ่ึงระดบัความเขม้ขน้ของแอลกอฮอล์
จากปอดจะสัมพนัธ์โดยตรงกบัระดบัความเขม้ขน้ของแอลกอฮอล์ในเลือด ดงันั้นเม่ือหายใจออกมา 
แอลกอฮอล์จะถูกขบัออกจากปอดดว้ยเช่นกนั 
 
 2.4.1   เซนเซอร์ตรวจวดัแอลกอฮอล์ 
 เซนเซอร์ตรวจสอบปริมาณแอลกอฮอล์ในลมหายใจนั้น มีหลกัการคร่าวๆคือ เม่ือเราเร่ิม
จ่ายพลังงานให้ตวัเซนเซอร์ท่ีขา H จะเกิดความร้อนข้ึนท่ีขดลวด และเม่ือแอลกอฮอล์ เข้ามาท า
ปฏิกิริยาจะท าให ้ค่าความตา้นทานท่ีเกิดข้ึนระหวา่ง ขา A และ B (RS)ลดลง 

จากรูปดา้นล่าง เม่ือจ่ายพลงังานให้กบั ขา H จะท าให้เกิดพลงังานความร้อนเพื่อให้สารเคมี
ภายในตวั Sensor สามารถท าปฏิกิริยากบัแอลกอฮอล์ได ้และเม่ือเซนเซอร์ตรวจจบัแอลกอฮอล์ได้
จะท าให้ค่าความตา้นทานระหวา่ง ขา A และ ขา B เปล่ียนแปลง (ขา A และ B เป็นขาท่ีไม่ตายตวัเรา
สามารถก าหนดเองไดโ้ดยเลือกขาใดเป็นขา A ขาท่ีอยู่ฝ่ังตรงขามก็จะเป็นขา B) โดยเม่ือเซนเซอร์
ตรวจจบัปริมาณก๊าซพิษต่างๆ ได้มากจะท าให้ค่าความตา้นทาน RS ลดลง หรือ ค่าความตา้นทาน
แปรผกผนักบัปริมาณของ ก๊าซไวไฟต่างๆ นัน่เอง 
 

 
 

รูปท่ี 2-2   แสดงโครงสร้างทางวงจรไฟฟ้าของเซนเซอร์ตรวจวดัแอลกอฮอล์ 
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วธีิการหาค่าความต้านทาน RS 

การหาค่าความตา้นทานของของ RS สามารถท าได ้2 วธีิคือ 

วธีิท่ี 1 สามารถใช ้Ohm meter วดัหาค่าความตา้นทานท่ีขา A และ B ไดโ้ดยตรง 

 

รูปท่ี 2-3   แสดงวธีิหาค่าความตา้นทาน RS โดยใช ้Ohm meter 

 

วธีิท่ี 2 เป็นวธีิการวดัโดยออ้ม โดยใชก้ฎแบ่งแรงดนั Voltage Divider 

 

รูปท่ี 2-4   แสดงวธีิหาค่าความตา้นทาน RS โดยใชก้ฎแบ่งแรงดนั Voltage Divider (ก) 
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จากรูปตามแถบสีเขียว จะเห็นวา่เราจ่ายกระแสไฟฟ้าเขามาทาง ขา A or B ทางดา้นซ้าย ซ่ึง
เม่ือน ามาจดัเรียงใหม่ใหเ้ป็นรูปท่ีเราคุน้ตากบั กฎแบ่งแรงดนัจะเป็นรูปภาพดงัน้ี 

 

 

รูปท่ี 2-5   แสดงวธีิหาค่าความตา้นทาน RS โดยใชก้ฎแบ่งแรงดนั Voltage Divider (ข) 

 

การหาค่า RS โดยใช้กฎแบ่งแรงดนัน้ีสามารถน าไปใช้กับ Microcontroller ได้โดยน าค่า 
Out put ท่ีได้ป้อนเข้าขา ADC ของ Microcontroller (การป้อนแรงดนัเขาขา ADC ของ MCU ตอ้ง
แน่ใจว่าระดับแรงดันท่ีป้อนเข้าไปไม่เกินกว่าท่ี Port ADC ของ MCU จะรับได้) และจะเห็นว่า 
แรงดนัไฟฟ้าท่ีวดัไดจ้ะมีค่ามากข้ึนเม่ือ RS ลดลง 
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ตัวอย่างการใช้งานเซนเซอร์กบับอร์ดไมโครคอนโทรลเลอร์ Arduino 

ต่อเซนเซอร์เขา้กบับอร์ดไมโครคอนโทรเลอร์ Aduino ตามรูป 

 

รูปท่ี 2-6   แสดงการต่อเซนเซอร์ตรวจวดัแอลกอฮอลเ์ขา้กบับอร์ดไมโครคอนโทรเลอร์
ชนิด Arduino 

 

ตัวอย่าง Code 

int adcPin = 0; 
int adcValue = 0; 
float v; 
float rs,ppm; 
void setup ()  
{ 
      Serial.begin (9600); 
      delay (2000);   
} 
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void loop () 
{ 
      adcValue = analogRead(adcPin); 
      v = adcValue*(5.00/1024); 
      rs=(100-(20.00*v))/v; 
      Serial.print("Volt out put");        
      Serial.println (v); 
      Serial.print("RS=");        
      Serial.println (rs); 
      delay (1000); 
} 

  

2.4.2   บอร์ดไมโครคอนโทรเลอร์ Arduino 

  บอร์ด Arduino ถือว่าเป็น Open Hardware Platform ท่ีถูกพฒันาข้ึนโดยมี Micro-
controller ของ Atmel เป็นหัวใจหลกั บอร์ด Arduino ท่ีผลิตออกมาจ าหน่ายในปัจจุบนัมีทั้งหมด 20 
รุ่น แต่ละรุ่นจะมีลกัษณะภายนอกท่ีแตกต่างกนั รวามถึงคุณสมบติัต่างๆดว้ย (บอร์ดบางรุ่นใช้ช่ือ
เดี ยวกันแต่ มี รายละเอี ยดของ spec แตก ต่ างกัน  เช่น  บอ ร์ด รุ่น  Arduino Pro กับ  Arduino 
Nano, LilyPad Arduino) 
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รูปท่ี 2-7   บอร์ดไมโครคอนโทรเลอร์ Arduino ชนิดต่างๆ 
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รายละเอยีดคุณสมบัติของบอร์ด Arduino แต่ละตัว 

ตารางท่ี 2-4   แสดงรายละเอียดคุณสมบติัของบอร์ด Arduino แต่ละตวั 

Board Micro-controller Clock Speed Flash Memory SRAM EEPROM 
Arduino UNO ATmega328 16 MHz 32 KB 2 KB 1 KB 
Arduino Lenonardo ATmega32u4 16 MHz 32 KB 2.5 KB 1 KB 
Arduino DUE AT91SAM3X8E 84 MHz 512 KB 96 KB - 
Arduino YUN ATmega32u4 16 MHz 32 KB 2.5 KB 1 KB 
Arduino Mega ADK ATmega2560 16 MHz 256 KB 8 KB 4 KB 
Arduino Ethernet  ATmega328 16 MHz 32 KB 2 KB 1 KB 
Arduino Mega 2560 ATmega2560 16 MHz 256 KB 8 KB 4 KB 
Arduino BT (Bluetooth) ATmega328 16 MHz 32 KB 2 KB 1 KB 
Arduino Micro ATmega32u4 16 MHz 32 KB 2.5 KB 1 KB 
Arduino Pro Mini ATmega168 8 MHz 16 KB 1 KB 512 Bytes 
Arduino Pro ATmega168 8 MHz 16 KB 1 KB 512 Bytes 
Arduino Pro ATmega328 16 MHz 32 KB 2 KB 1 KB 
Arduino Mini ATmega328 16 MHz 32 KB 2 KB 1 KB 
Arduino Nano ATmega168 16 MHz 16 KB 1 KB 512 Bytes 
Arduino Nano ATmega328 16 MHz 32 KB 2 KB 1 KB 
Arduino Fio ATmega328P 8 MHz 32 KB 2 KB 1 KB 
Arduino Robot ATmega32u4 16 MHz 32 KB 2.5 KB 1 KB 
Arduino Esplora ATmega32u4 16 MHz 32 KB 2.5 KB 1 KB 
LilyPad Arduino USB ATmega32u4 8 MHz 32 KB 2.5 KB 1 KB 
LilyPad Arduino Simple ATmega328 8 MHz 32 KB 2 KB 1 KB 
LilyPad Arduino SimpleSnap ATmega328 8 MHz 32 KB 2 KB 1 KB 
LilyPad Arduino ATmega168V 8 MHz 16 KB 1 KB 512 Bytes 
LilyPad Arduino ATmega328V 8 MHz 16 KB 1 KB 512 Bytes 
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2.5   พืน้ฐานไมโครคอนโทรลเลอร์ด้วย Arduino 

 2.5.1   ไมโครคอนโทรลเลอร์คืออะไร 
ไมโครคอนโทรลเลอร์ คือ อุปกรณ์ท่ีมีหน่วยประมวลผลและความจ าขนาดเล็กภายใน

ตวัเอง สามารถรับ ส่ง ขอ้มูลไดท้ั้งแบบดิจิตอลและอนาล็อก ใช้พลงังานน้อย ท าให้เป็นท่ีนิยมใน
การใชง้านในรูปแบบท่ีเรียกวา่ Embedded เช่น เคร่ืองใชไ้ฟฟ้าอจัฉริยะทั้งหลาย 

โครงสร้างโดยทัว่ไป ของไมโครคอนโทรลเลอร์นั้น สามารถแบ่งออกมาได้เป็น 5 ส่วน
ใหญ่ๆ ดงัต่อไปน้ี 

1. หน่วยประมวลผลกลางหรือซีพยูี (CPU : Central Processing Unit) 
2. หน่วยความจ า (Memory) สามารถแบ่งออกเป็น 2 ส่วน คือ หน่วยความจ าท่ีมีไวส้ าหรับ

เก็บโปรแกรมหลกั (Program Memory) เปรียบเสมือนฮาร์ดดิสกข์องเคร่ืองคอมพิวเตอร์ตั้ง
โต๊ะ คือข้อมูลใดๆ ท่ีถูกเก็บไวใ้นน้ีจะไม่สูญหายไปแม้ไม่มีไฟเล้ียง อีกส่วนหน่ึงคือ
หน่วยความจ าขอ้มูล (Data Memory) ใช้เป็นเหมือนกกระดาษทดในการค านวณของซีพีย ู
และเป็นท่ีพกัขอ้มูลชัว่คราวขณะท างาน แต่หากไม่มีไฟเล้ียง ขอ้มูลก็จะหายไปคล้ายกบั
หน่วยความแรม (RAM) ในเคร่ืองคอมพิวเตอร์ทัว่ๆ ไป แต่ส าหรับไมโครคอนโทรลเลอร์
สมยัใหม่ หน่วยความจ าขอ้มูลจะมีทั้งท่ีเป็นหน่วยความจ าแรม ซ่ึงขอ้มูลจะหายไปเม่ือไม่มี
ไฟ เล้ียง และเป็น อี อีพรอม(EEPROM : Erasable Electrically Read-Only Mempry) ซ่ึ ง
สามารถเก็บขอ้มูลไดแ้มไ้ม่มีไฟเล้ียง 

3. ส่วนติดต่อกับอุปกรณ์ภายนอก หรือพอร์ต (Port) มี 2 ลักษณะคือ พอร์ตอินพุต (Input 
Port) และพอร์ตส่งสัญญาณหรือพอร์ตเอาต์พุต (Output Port) ส่วนน้ีจะใช้ในการเช่ือมต่อ
กบัอุปกรณ์ภายนอก ถือว่าเป็นส่วนท่ีส าคญัมาก ใช้ร่วมกนัระหว่างพอร์ตอินพุต เพื่อรับ
สัญญาณ อาจจะด้วยการกดสวิตช์ เพื่อน าไปประมวลผลและส่งไปพอร์ตเอาต์พุต เพื่อ
แสดงผลเช่น การติดสวา่งของหลอดไฟ เป็นตน้ 

4. ช่องทางเดินของสัญญาณ หรือบัส (BUS) คือเส้นทางการแลกเปล่ียนสัญญาณข้อมูล
ระหวา่ง ซีพีย ูหน่วยความจ าและพอร์ต เป็นลกัษณะของสายสัญญาณ จ านวนมากอยูภ่ายใน
ตวัไมโครคอนโทรลเลอร์ โดยแบ่งเป็นบสัขอ้มูล (Data Bus) , บสัแอดเดรส (Address Bus) 
และบสัควบคุม (Control Bus) 

5. วงจรก าเนิดสัญญาณนาฬิกา นบัเป็นส่วนประกอบท่ีส าคญัมากอีกส่วนหน่ึง เน่ืองจากการ
ท างานท่ีเกิดข้ึนในตวัไมโครคอนโทรลเลอร์ จะข้ึนอยูก่บัการก าหนดจงัหวะ หากสัญญาณ

 

 

 

 

 

 

 

 

http://th.wikipedia.org/wiki/%E0%B8%AE%E0%B8%B2%E0%B8%A3%E0%B9%8C%E0%B8%94%E0%B8%94%E0%B8%B4%E0%B8%AA%E0%B8%81%E0%B9%8C
http://th.wikipedia.org/w/index.php?title=%E0%B8%AD%E0%B8%B5%E0%B8%AD%E0%B8%B5%E0%B8%9E%E0%B8%A3%E0%B8%AD%E0%B8%A1&action=edit&redlink=1
http://th.wikipedia.org/w/index.php?title=%E0%B8%A7%E0%B8%87%E0%B8%88%E0%B8%A3%E0%B8%81%E0%B8%B3%E0%B9%80%E0%B8%99%E0%B8%B4%E0%B8%94%E0%B8%AA%E0%B8%B1%E0%B8%8D%E0%B8%8D%E0%B8%B2%E0%B8%93%E0%B8%99%E0%B8%B2%E0%B8%AC%E0%B8%B4%E0%B8%81%E0%B8%B2&action=edit&redlink=1
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น า ฬิ ก า มี ค ว าม ถ่ี สู ง  จั ง ห ว ะ ก ารท า ง าน ก็ จ ะ ส าม ารถ ท า ไ ด้ ถ่ี ข้ึ น ส่ ง ผ ล ให้
ไมโครคอนโทรลเลอร์ตวันั้น มีความเร็วในการประมวลผลสูงตามไปดว้ย 

 

 
 
รูปท่ี 2-8   แสดงการส่งขอ้มูลของตวั Microcontroller  
 
 

 
 
รูปท่ี 2-9   สถาปัตยกรรมพื้นฐานของ Microcontroller 
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เราสามารถเพิ่มค าสั่งในการควบคุม Microcontroller ไดด้ว้ยการเขียนโปรแกรม เช่น 

 ภาษา Assemble(Low Level) เขียนโปรแกรมหลายบรรทัด แต่การท างานของ micro 
controller มีความเร็วสุดเพราะถูกคอมไพลเ์ป็นภาษาเคร่ือง 

 ภาษา C(Middle Level)เขียน โปรแกรมจ านวนน้อยบรรทดักวา่ ภาษา Assemble ท างานจะ
ช้ากว่าเป็นวินาที แต่ปัจจุบันอุปกรณ์ได้พัฒนาจนมีความเร็วในการท างานของ micro 
controller ใหท้  างานรวดเร็วจนเกือบเทียบเท่า ภาษา Assemble แลว้ 

          ภาษาแสตมป์ จดัเป็นภาษาท่ีช่วยให้การโปรแกรมอุปกรณ์ดว้ยภาษาท่ีคนส่วนมากพื้นความ
รู้อยูแ่ลว้มาต่อยอด ในการพฒันาระบบไมโครคอนโทลเลอร์ ดว้ยตระกลู PIC(Stamp) 

 ภาษา Basic Stamp 
 ภาษา Java Stamp 

 
2.5.2   Arduino คืออะไร 

Arduino (อ่านวา่ อา-ดู-อิ-โน่ หรือจะอ่านวา่ อาดุยโน่ ก็ได)้ คือ ไมโครคอนโทรลเลอร์ชนิด
หน่ึง ซ่ึงเป็นแบบท่ีเรียกว่า Open Hardware กล่าวคือ Arduino อุปกรณ์ท่ีมีแบบส่วนประกอบเป็น
มาตรฐานท่ีเปิดเผย หมายความว่า เราสามารถท าเองโดยใช้แบบท่ีมีการเปิดเผยทั่วไปก็ได้ หรือ
สามารถซ้ือหาไดง่้าย มีราคาถูก มีซ๊อพตแ์วร์ใหใ้ชง้านฟรี สามารถน าไปใชง้านทัว่ไปหรือแบบธุรกิจ
ไดโ้ดยไม่ตอ้งเสียค่าลิขสิทธ์ิ เป็นรูปแบบท่ีมีขอ้มูลมากท่ีสุดบนอินเตอร์เน็ต การพฒันาก็ง่าย เพราะ
มีตวัอย่างมากมาย และไม่ตอ้งเขียนโปรแกรมในรูปแบบ Low Level หมายความวา่ เราสามารถใช้
ค  าสั่งเขียนโปรแกรมไดเ้สมือนโปรแกรมภาษาชั้นสูงทัว่ไป 

ในต่างประเทศมหาวิทยาลัยด้านสถาปัตยกรรมคอมพิวเตอร์ได้ก่อตั้ งโครงการพฒันา
ฮาร์ดแวร์และซอฟตแ์วร์ในลกัษณะโอเพ่นซอร์ส (open source) เพื่อสนบัสนุนการเรียนรู้การเขียน
โปรแกรมคอมพิวเตอร์และความรู้เก่ียวกบัวงจรอิเล็กทรอนิกส์ เพื่อให้สามารถสร้างระบบควบคุม
อตัโนมติัได ้ผูก่้อตั้งโครงการ Wiring คือ เฮอร์นนัโด ้บาราแกน (Hernando Barragan) แห่ง ภาควิชา
ออกแบบและสถาปัตยกรรม (Architecture and Design School) ของมหาวิทยาลัย Universidad de 
Los Andes ประเทศโคลมัเบีย 

ปัจจุบนัโครงการ Wiring น้ียงัไดรั้บการพฒันาอยา่งต่อเน่ือง และมีการน าไปปรับใชใ้นการ
เรียนการสอนทั้งในคณะวิศวกรรมศาสตร์และ สถาปัตยกรรมศาสตร์ในมหาวิทยาลยัทัว่โลก แต่ 
Wiring นั้นใช ้chip ของ AVR ท่ีมีราคาแพงจึงเกิดการต่อยอดมาเป็น Arduino 
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        Arduino เป็นรูปแบบของ Microcontroller ใช้ AVR chip ราคาประหยัดและมีซอฟต์แวร์
ส าหรับพฒันาไดทุ้ก Platform  Windows,Linux และ OSX ควบคุมอุปกรณ์อิเลคทรอนิคส์ แลว้จึงท า
การคอมไพลเ์พื่อ upload เขา้วงจรโดยใชภ้าษาคอมพิวเตอร์ C/C++ สามารถท าการลบแลว้เขียนใหม่
ไดจ้นกวา่จะหมดอายุ(เป็นพนัคร้ัง)  โดยสามารถพฒันาไดโ้ดยไม่ตอ้งลงลึกเร่ืองอิเลคฯ หรือไฟฟ้า
ก าลงั เพราะ Arduino มี Library ช่วยเหลือจึงง่ายในการท าโปรเจคด้วย Micocontroller ยกตวัอย่าง 
เช่น  

 เขียน program สั่งการไฟ led เปิดแต่ละดวงวนลูปไปมา 
 เขียน programสั่งใหเ้ล่น ดนตรีใหอ้อกจากล าโพงบซัเซอร์ได ้
 เขียนสั่งบงัคบัมอเตอร์ servo ได ้
 เขียน program ให้รับเง่ือนไขได ้โดยใชอุ้ปกรณ์ท่ีใชรั้บค่า เช่น ปุ่มกดติดปล่อยดบั,ส่วนรับ

ค่า sensor ได ้เช่น LDR ท่ีรับแสง 
 ฯลฯ 

 
 

รูปท่ี 2-10   หนา้ตาของ Arduino Software Developer 

 

 

 

 

 

 

 

 

http://www.duinothumb.com/articles/platform-arduino-open-hard/Arduino_IDE_-_v0011_Alpha.png?attredirects=0
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2.5.3   ตัวอย่างการใช้ Arduino กบับอร์ดไมโครคอนโทรลเลอร์ 
1.   เปิดโปรแกรม Arduino IDE ท่ีดาวน์โหลดมา

จาก http://arduino.cc/en/Main/Software 

2.   เม่ือเปิดโปรแกรมแลว้จะพบกบัหนา้ต่างของ IDE ดงัรูป 

 

3.   ไปท่ี Tools->Board แลว้เลือกให้ตรงกบับอร์ดท่ีใชง้าน ส าหรับ Arduino UNO 
R3 ใหเ้ลือกบอร์ด Arduino UNO 

4.   เขียนโปรแกรมดงัขอ้ความดา้นล่างน้ี 

 

 

 

 

 

 

 

 

http://arduino.cc/en/Main/Software
http://www.ec.in.th/index.php?route=product/product&product_id=1002
http://www.ec.in.th/index.php?route=product/product&product_id=1002
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5.   จากนั้นคอมไฟลโ์ปรแกรมโดยไปท่ี Sketch->Verify / Compile 
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6.   เม่ือคอมไฟลเ์รียบร้อยจะมีขอ้ความปรากฏดงัรูป 

 

7.   ต่อบอร์ด Arduino UNO R3 เขา้กบัคอมพิวเตอร์ผา่นทางพอร์ต USB 

 

 

 

 

 

 

 

 

 

http://www.ec.in.th/index.php?route=product/product&product_id=1002
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8.   จากนั้นให้ไปท่ี Tools->Serial Port และเลือกให้ตรงกบับอร์ด Arduino UNO ท่ี
ใชง้าน (ส าหรับบอร์ด Arduino UNO R3 โปรแกรมจะเลือกใหอ้ตัโนมติั) 

 

9.   โหลดโปรแกรมเขา้บอร์ด Arduino UNO โดยไปท่ี File->Upload 
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10.   จากนั้ น เปิ ด  Serial Monitor ของ  Arduino IDE โดยไป ท่ี  Tools-> Serial 
Monitor 

 

11. เม่ือเปิด Serial Monitor จะไดข้อ้ความดงัรูป 
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บทที ่ 3 
หลกัการท างานของอปุกรณ์และโปรแกรม 

ในการใช้งานเคร่ืองวดัระดับแอลกอฮอล์ด้วยลมหายใจ 
 
3.1   บทน า 
 เน้ือหาในบทน้ีจะกล่าวถึงโครงสร้างของเคร่ืองวดัระดบัแอลกอฮอล์ดว้ยลมหายใจ หนา้ท่ี
และการใชง้านส่วนประกอบต่างๆ การเขียนโปรแกรมและใชโ้ปรแกรมควบคุมการท างาน และการ
เช่ือมต่อส่วนประกอบต่างๆ ใหท้  างานร่วมกนั 

 
3.2   โครงสร้างของเคร่ืองวดัระดับแอลกอฮอล์ด้วยลมหายใจ 

เคร่ืองวดัระดบัแอลกอฮอล์ดว้ยลมหายใจน้ี มีโครงสร้างในการท างานซ่ึงประกอบไปดว้ย

เซนเซอร์วดัแอลกอฮอล์ TGS 2620 บอร์ดไมโครคอนโทรลเลอร์ Arduino (รุ่น Arduino Uno R3) 

โปรแกรม Arduino IDE ท่ีใช้เขียนโปรแกรมลงในบอร์ดไมโครคอนโทรลเลอร์ Arduino และ

อุปกรณ์แสดงผลในการวดัระดบัแอลกอฮอล์ประกอบไปดว้ยจอแสดงผล LCD หลอดไฟ LED และ

ล าโพงบซัเซอร์ (Buzzer) 

 

รูปท่ี 3-1   โครงสร้างของเคร่ืองวดัระดบัแอลกอฮอลด์ว้ยลมหายใจ 

Buzzer 
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3.3   Hardware ของเคร่ืองวดัระดับแอลกอฮอล์ด้วยลมหายใจ 

3.3.1  เซนเซอร์วดัแอลกอฮอล์ TGS 2620 

อุปกรณ์ท่ีใช้วดัระดบัแอลกอฮอล์ดว้ยการเป่าลมหายใจท่ีจะใช้ในโครงงานน้ีคือเซนเซอร์ 

TGS 2620 ซ่ึงเซนเซอร์วดัแอลกอฮอล์ตวัน้ีใชส้ารในการตรวจจบัท าจากชั้นของสารก่ึงตวัน าท่ีเป็น

ออกไซด์ของโลหะ ซ่ึงอยูบ่นพื้นผิวออกไซด์ของอะลูมิเนียม ของตวัตรวจจบัและตวัท าความร้อน 

เม่ือมีแก๊สท่ีตรวจจบัไดใ้นอากาศ สภาพการน าไฟฟ้าของตวัตรวจจบัจะเพิ่มข้ึนโดยข้ึนอยูก่บัความ

เขม้ขน้ของแก๊สในอากาศ วงจรอิเล็กทรอนิกส์อย่างง่ายจะแปลผลการเปล่ียนแปลงสภาพการน า

ไฟฟ้าและแสดงผลเป็นความเข้มข้นของแก๊ส เซนเซอร์ TGS 2620 มีความไวต่อตัวท าละลาย

อินทรียสู์ง รวมทั้งสารระเหยอ่ืนๆ นอกจากน้ียงัไวต่อแก๊สท าให้มนัเป็นตวัตรวจจบัท่ีดี  เน่ืองจาก

ขนาดท่ีเล็กของชิพในเซนเซอร์ TGS 2620 ใชไ้ฟฟ้าเพียง 42 mA 

 

 
 

รูปท่ี 3-2   วงจรพื้นฐานของเซนเซอร์ TGS 2620 
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วงจรการวดัพืน้ฐาน 

ตัวตรวจจับต้องการไฟฟ้า 2 ทาง: heater voltage (VH) และ Circuit voltage (VC) โดย 

Heater voltage ถูกใช้ในการรวมตัวท าความร้อนเพื่อรักษาระดับอุณหภูมิให้เหมาะสมต่อการ

ตรวจจบั ส่วน Circuit voltage ถูกใช้เพื่อให้ Measurement of voltage (VRL) ผา่น Load resistor ซ่ึง

เช่ือมต่ออยูก่บัตวัตรวจจบั Power supply circuit ทัว่ไปสามารถใชส้ าหรับ VC และ VH เพื่อให้วงจร

ท างานโดยค่าของ load resistor ท่ีใชค้วรเหมาะสมต่อค่าเร่ิมตน้ท่ีจะให้มีการเตือน โดยรักษาการใช้

ไฟฟ้า (PS) ของ Semiconductor ให้ต ่ากวา่ 15 mW การใชไ้ฟฟ้าจะสูงสุดเม่ือค่าของ RS เท่ากบั RL  

ซ่ึงสามารถหาค่า Rs ไดจ้ากสูตรการแบ่งแรงดนั ดงัน้ี 

Rs=  
 

คุณลกัษณะของการตอบสนองพืน้ฐาน 

 

 

รูปท่ี 3-3   กราฟแสดงการตอบสนองของก๊าซชนิดต่างๆ 
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จากรูปท่ี 3-3 แสดงถึงการตอบสนองของเซนเซอร์ TGS 2620 ท่ีก๊าซชนิดต่างๆ โดยกราฟ

แสดงถึงอตัราส่วนระหวา่งความตา้นทานของเซนเซอร์ (Rs) กบัความตา้นทานเซนเซอร์ท่ี 300ppm 

(Ro) เทียบกบั PPM (part per million) 

 จากการประยุกตใ์ชว้งจรการวดัพื้นฐานในรูปท่ี1 กบัสูตรการแบ่งแรงดนั Rs จะท าให้ไดค้่า

แรงดนัเอาทพ์ุต (VRL) ท าใหไ้ดค้่าท่ีแสดงความสัมพนัธ์เป็นกราฟดงั รูปท่ี 3-4 

 

รูปท่ี 3-4   กราฟแสดงความสัมพนัธ์ระหวา่ง VRL กบัความเขม้ขน้ของก๊าซท่ีตรวจจบัได ้(PPM) 

เลือกพิจารณาเฉพาะเส้นกราฟของEthanolเพื่อหาสมการ โดยการน าค่าไปเขียนกราฟใน

โปรแกรม Microsoft Excel แลว้ท าการหาค่าแนวโนม้และสมการออกมา จะไดก้ราฟดงัน้ี 

 

รูปท่ี 3-5   กราฟแสดงความสัมพนัธ์ของแรงดนัเอาทพ์ุทกบั PPM 
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กราฟจะถูกแบ่งออกเป็นสองช่วงเพื่อให้ค่าสมการของกราฟไดใ้กลเ้คียงกบักราฟตน้แบบ

ให้มากท่ีสุด โดยแกนxคือค่าของGas concentration (PPM)และแกนyคือค่าของVRL(V) จะได้

สมการดงัน้ี 

ช่วงแรก ;  0 < VRL ≤ 3 :  

Gas concentration(PPM)=  

ช่วงสอง ;  3 < VRL< 5 : 

Gas concentration(PPM) =  
 

ซ่ึงจากสมการขา้งตน้จะไดค้่าปริมาณของก๊าซออกมาเป็นหน่วยของPPM แต่ในท่ีน้ีตอ้งการ

ให้ค่าปริมาณของก๊าซเป็นหน่วยของแอลกอฮอล์ในเลือด(mg%) จึงตอ้งท าการเปรียบเทียบหน่วย

ดงัน้ี 

1 PPM  มีค่าเท่ากบั  mg/L 
1 mg%  มีค่าเท่ากบั  mg/dL 

     1mg%  จะมีค่าเท่ากบั   
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3.3.2   บอร์ดไมโครคอนโทรลเลอร์ Arduino รุ่น Arduino UNO R3 

 

 

รูปท่ี 3-6   บอร์ดไมโครคอนโทรเลอร์ Aduino UNO R3 

 

 Arduino UNO R3 เป็น Microcontroller board ท่ีใช้ ATmega328 เป็น MCU หลัก ซ่ึงตวัน้ี

จะมีขา Digital 14 ขา อินพุท/เอาท์พุท (สามารถท าเป็น PWM ไดถึ้ง 6 ขา) และมีขา Analog อินพุท

ได้ อีก  6 ขา, รัน ท่ี ความ ถ่ี  16 MHz มี  USB Connector และ  Power Jack DC ซ่ึ ง  Concept ของ 

Arduino Board น้ีท ามาเพื่อความสะดวก ง่ายในการเช่ือมต่อเขา้กบัคอมพิวเตอร์ สามารถต่อ USB 

เขา้กบัช่องคอมพอร์ตก็สามารถ Run โปรแกรมท่ี Board ได ้เหมาะส าหรับผูท่ี้ก าลงัเร่ิมตน้การเขียน

โปรแกรม  มีรายละเอียดโดยสรุปดงัน้ี 

 Microcontroller    ATmega328 

Operating Voltage   5V 

Input Voltage (recommended)  7-12V 
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Input Voltage (limits)   6-20V 

Digital I/O Pins    14 (of which 6 provide PWM output) 

Analog Input Pins   6 

DC Current per I/O Pin   40 mA 

DC Current for 3.3V Pin   50 mA 

Flash Memory  32 KB (ATmega328) of which 0.5 KB used by bootloader 

SRAM     2 KB (ATmega328) 

EEPROM    1 KB (ATmega328) 

Clock Speed    16 MHz 
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รูปท่ี 3-7   โครงสร้างของบอร์ด Aduino UNO R3 
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3.3.3   จอแสดงผล LCD 
 

 
 

รูปท่ี 3-8   การต่อ LCD เขา้กบับอร์ด Arduino 

สามารถต่อบอร์ด Aduino กบั LCD ไดด้งัน้ี 
-   LCD RS ต่อกบั Digital 12 
-   LCD Enable ต่อกบั Digital 11 
-   LCD D4 ต่อกบั Digital 5 
-   LCD D5 ต่อกบั Digital 4 
-   LCD D6 ต่อกบั Digital 3  
-   LCD D7 ต่อกบั Digital 2 
-   LCD Gnd และ LCD R/W ต่อเขา้กบั ขาขา้งซา้ยหรือขวาของ 10K pot ก็ไดค้รับ แลว้ต่อเขา้ GND  
-   LCD Vcc ต่อกบั ขาอีกขา้งของ 10K pot แลว้ต่อเขา้ 5V ครับ 
-   LCD VO ต่อกบั ขากลางของ 10K pot ครับ 
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3.3.4   หลอดไฟ LED 
 

 
รูปท่ี 3-9   ส่วนประกอบของ Light-Emitting Diode 

 
LED ย่อมาจาก Light-Emitting Diode หรือเรียกว่าไดโอดเปล่งแสงซ่ึงสามารถเปล่งแสง

ออกมาได้แสงท่ีเปล่งออกมาประกอบด้วยคล่ืนความถ่ีเดียวและเฟสต่อเน่ืองกนั ซ่ึงต่างกับแสง
ธรรมดาท่ีตาคนมองเห็น โดยหลอดLED สามารถเปล่งแสงไดเ้ม่ือจ่ายกระแสไฟฟ้าเขา้เพียงเล็กนอ้ย
เท่านั้น และประสิทธิภาพในการให้แสงสว่างก็ยงัดีกว่าหลอดไฟขนาดเล็กทัว่ๆไป ไดโอดชนิดน้ี
เหมือนไดโอดทัว่ ๆ ไปท่ีประกอบดว้ยสารก่ึงตวัน าชนิด P และ N ประกบกนัมีผวิขา้งหน่ึงเรียบเป็น
มนัคล้ายกระจก เม่ือไดโอดตกไบแอสตรงจะท าให้อิเลคตรอนท่ีสารก่ึงตวัน าชนิด N มีพลงังาน
สูงข้ึนจนสามารถวิง่ขา้มรอยต่อไปรวมกบัโฮลใน P ต่อใหเ้กิดพลงังานในรูปของประจุโฟตอนซ่ึงจะ
ส่งแสงออกมา 
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3.3.5   Buzzer (EMB – 2306L) 

 
รูปท่ี 3-10   Buzzer 

 
ขนาด     23*16 mm 
ช่องสัญญาณเสียง   รางเด่ียว 

  แรงดนัไฟฟ้ามาตรฐาน     6 V 
  แรงดนัไฟฟ้าในปฏิบติัการ    4 – 8 V 
  กระแสไฟฟ้า       25 mA 
  เสียงเอาทพ์ุทท่ี 20 cm     75 dB 
  ความถ่ีของเสียง       400 Hz 
  น ้าหนกั         10 g 
 

 

รูปท่ี 3-11   แสดงขนาดและกราฟคุณสมบติัเปรียบเทียบระหวา่งความดงัในหน่วย dB ,กระแสไฟ 
และแรงดนั VDC ท่ีใชต้ามล าดบั 
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Yes 

Yes 

3.4 การเขยีนโปรแกรมของเคร่ืองวดัแอลกอฮอล์ 
 
3.4.1 แผนผงัการท างานของโปรแกรม (Flow chart)  
 
 

 
     
  

 
                                                                                
                                                                                                                         
  
 
 
           
                                                                         
                                                                                                                           
 
 
 
 
 

START 

อ่านค่า Volt จาก
Sensor 

Volt > 3 

Mg% =  Mg% =  

mg% > 50 

แสดงค่า mg% 

แสดงค่า mg% และ
เสียงเตือนท่ีออดและ
ไฟ LED ติด (3 วนิาที) 

STOP 

No 

No 
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3.4.2   Code program และค าอธิบาย 
 
// include the library code: 
#include <math.h>   //การเรียกLibrary Math 
#include <LiquidCrystal.h>  //การเรียกLibrary LiquidCrystal ใชใ้นการเขียนLCD  
// initialize the library with the numbers of the interface pins 
LiquidCrystal lcd(2, 4, 5, 15, 16, 17); //(RS, Enable, D4, D5, D6, D7) 
#define d3 3    //ก าหนดให้d3 คือขา3 
#define d6 6    //ก าหนดให้d6 คือขา6 
#define d7 7    //ก าหนดให้d7 คือขา7 
void setup(){ 
  lcd.begin(16, 2); // set up the LCD's number of columns and rows:  
  Serial.begin(9600); // initialize the serial communications: 
  pinMode(d3, OUTPUT);  //ก าหนดให้d3เป็นoutputเขา้สู่analog write 
  pinMode(d6, OUTPUT);  //ก าหนดให้d6เป็นoutputเขา้สู่ออดกล 
  pinMode(d7, OUTPUT);  //ก าหนดให้d7เป็นoutputเขา้สู่LED 
  analogWrite(3, 100);   //ใชก้  าหนดความเขม้ตวัหนงัสือ 
} 
double analog_in = 0;   //setค่าเร่ิมตน้ของตวัแปร 
double v = 0;    //setค่าเร่ิมตน้ของตวัแปร 
double ppm = 0;   //setค่าเร่ิมตน้ของตวัแปร 
double mg_per = 0;   //setค่าเร่ิมตน้ของตวัแปร 
void loop(){ 
  while(1){ 
    analog_in = analogRead(0);  //ใชค้่าA0อ่านค่า analogRead แลว้เก็บค่าใน analog_in 
    v = (analog_in*5)/1023;  //แปลงต่าจากv=0-1023v ใหเ้ป็นv=0-5v 
    Serial.print(v, 4);   //ก าหนดตวัแปรvเก็บค่าทศนิยม4ต าแหน่ง 
    Serial.print("V");   //แสดงค่าตวัแปรvในserial monitor 
    Serial.print("\t\t"); 
    if(v<=3){    //ถา้V 3ใหท้ าตามเง่ือนไขต่อไปน้ี 
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      ppm = exp((v+3.4089)/1.1215); //แทนVท่ีอ่านไดล้งในสูตร 
      Serial.print(ppm, 4);   //ก าหนดตวัแปรppmเก็บค่าทศนิยม4ต าแหน่ง 
      Serial.print("ppm");   //แสดงค่าตวัแปรppmในserial monitor 
      Serial.print("\t"); 
      mg_per = ppm/10;   //น าppm 10จะไดค้่าmg% 
      lcd.setCursor(0, 0); // set the cursor to column 0, line 0 
      lcd.print("Alcohol Meter   ");  //แสดงค าวา่ Alcohol Meter บนLCD 
      lcd.setCursor(0, 1); // set the cursor to column 0, line 1 
      lcd.print("Value = ");   //แสดงค าวา่ Value =  บนLCD 
      lcd.print(mg_per, 0);   //แสดงค่าmg% บนLCD 
      lcd.print(" mg%    ");   //แสดงค าวา่ mg%บนLCD 
    } 
   else if(v>3){    //ถา้V 3ใหท้ าตามเง่ือนไขต่อไปน้ี 
      ppm = exp((v-0.1674)/0.5055); //แทนVท่ีอ่านไดล้งในสูตร 
      Serial.print(ppm, 4);   //ก าหนดตวัแปรppmเก็บค่าทศนิยม4ต าแหน่ง 
      Serial.print("ppm");   //ก าหนดตวัแปรppmเก็บค่าทศนิยม4ต าแหน่ง 
      Serial.print("\t"); 
      mg_per = ppm/10;    //น าppm÷10จะไดค้่าmg% 
      lcd.setCursor(0, 0); // set the cursor to column 0, line 0  
      lcd.print("Alcohol Meter   ");  //แสดงค าวา่ Alcohol Meter บนLCD 
      lcd.setCursor(0, 1); // set the cursor to column 0, line 1 
      lcd.print("Value = ");   //แสดงค าวา่ Value =  บนLCD 
      lcd.print(mg_per, 0);   //แสดงค่าmg% บนLCD 
      lcd.print(" mg%    ");   //แสดงค าวา่ mg%บนLCD 
      if(mg_per>=50){   //ถา้mg%  
        digitalWrite(d6, HIGH);  //ก าหนดใหอ้อดกลดงั 
        digitalWrite(d7, HIGH);  //ก าหนดให้LEDติด 
        delay(500);    //ก าหนดให้LEDติด500ms 
        digitalWrite(d7, LOW);  //ก าหนดให้LEDดบั 
        delay(500);    //ก าหนดให้LEDดบั500ms 
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        digitalWrite(d7, HIGH);  //ก าหนดให้LEDติด 
        delay(500);    //ก าหนดให้LEDติด500ms 
        digitalWrite(d7, LOW);  //ก าหนดให้LEDดบั 
        delay(500);    //ก าหนดให้LEDดบั500ms 
        digitalWrite(d7, HIGH);  //ก าหนดให้LEDติด 
        delay(1000);   //ก าหนดให้LEDติด1000ms 
        digitalWrite(d6, LOW);  //ก าหนดใหอ้อดกลดบั 
        digitalWrite(d7, LOW);  //ก าหนดให้LEDดบั 
      } 
      else{  
      } 
    } 
    Serial.print("Value Alcohol ");  //แสดงค าวา่ Value  Alcohol บนserial monitor 
    Serial.print(mg_per, 4);  //ก าหนดใหแ้สดงค่าmg%เป็นทศนิยม4ต าแหน่งบน
serial monitor 
    Serial.println("mg%");   //แสดงค่า mg% บนserial monitor 
    delay(1000);    //อ่านค่าทุกๆ1วนิาที 
  } 
} 
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3.4.3   การเขียนโปรแกรม Arduino IDE 
  บอ ร์ดAduino นั้ น ต้อ ง เขี ยน ด้วยโป รแกรม  Arduino IDE ( Integrated Development 
Environment ) ซ่ึงตวัโปรแกรมตวัน้ีนั้นถูกพฒันาต่อมาจากโปรแกรม open source อยา่ง Processing 
และ Wiring และดว้ยความท่ีทั้งตวัโปรแกรม Processing และ Wiring นั้นถูกพฒันาข้ึนมาดว้ยภาษา 
JAVA จึงท าให้สามารถใช้งานได้ทั้ งบนระบบปฏิบัติการ Windows, Linux และ Mac OS ได้ ตัว
โปรแกรม Arduino IDE ถูกพฒันาข้ึนมาเพื่อให้ใชง้านไดง่้ายสะดวกและลดความซบั ซ้อนของการ
เขียนโปรแกรมในรูปแบบของภาษา C/C++ ให้ดูเรียบง่าย ไม่ซบัซ้อน มีค าสั่งและไลบราร่ีเตรียมไว้
ใหแ้ลว้ 
 

 ชนิดของตัวแปรในการเขียนโปรแกรม 
 Char มีขนาด  8 บิต  ใชแ้ทนขอ้มูล -128 ถึง 127 
 Int  มีขนาด  16 บิต  ใชแ้ทนขอ้มูลจ านวนเตม็ ในช่วง -32,768 ถึง +32,767 
 Long  มีขนาด  32 บิต  ใชแ้ทนขอ้มูลจ านวนเตม็ ในช่วง -2,147,483,648 ถึง +2,147,483,647 
 Float  มีขนาด  32 บิต  ใชแ้ทนขอ้มูลจ านวนจริงในช่วง 10 ยกก าลงั -38 ถึง 10 ยกก าลงั 38 
 Double  มีขนาด  64 บิต  ใชแ้ทนขอ้มูลจ านวนจริงในช่วง 10 ยกก าลงั -308 ถึง 10 ยกก าลงั 038 
 

 โครงสร้างการเขียนโปแกรม 
 #include<ประกาศLibrary > 
 ประกาศตวัแปรต่างๆ 
 void setup() { ก าหนดใชง้านportต่างๆ โดยใน arduino เรียก port ต่างๆเป็นหมายเลข 
 
} 
 void loop()  
{ 
 การก าหนดในการใชฟั้งกช์นัต่างๆ 
} 
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 MENU bar ของ Arduino IDE จะประกอบด้วย 
 
  1.  Menu File โดยท าหนา้ท่ีบริหารจดัการขอ้มูลท่ีเรียกวา่ Sketch File (ไฟลท่ี์ท าการเขียน
จะเรียกวา่ sketch files) 
 
   * New : สร้าง Sketch File ใหม่ 
 
   * Sketchbook : 
 
    1. Open : เรียก Sketchbook ท่ีบนัทึกไวก่้อนหนา้น้ี 
 
    2. Example :เปิด Sketchbook ตวัอยา่งท่ีมาจาก Library 
 
   * Save : บนัทึก Sketch File ณ.ปัจจุบนั 
 
   * Save as : บนัทึก Sketch File ในท่ี อ่ืนหรือช่ือใหม่ 
 
   * Upload to I/O board : การ burn สู่ MCU(AVR)หลงัจากท่ีเขียนโปรแกรมเสร็จ 
 
   * Preference : ตั้งค่าต่าง ๆ ของArduino IDE 
 
  2.  Edit Menu ท าหนา้ท่ีแกไ้ข wording 
 
   * Undo : ยกเลิกค าสั่งหรือการพิมพค์ร้ังล่าสุด 
 
   * Redo : ท าซ ้ าค  าสั่งหรือการพิมพค์ร้ังล่าสุด 
 
   * Cut : ตดัขอ้ความไวใ้น clipboard 
 
   * Copy : คดัลอกขอ้ความจาก clipboard 
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   * Paste : แปะขอ้ความจาก clipboard 
 
   * Select all : เลือก(แรเงา)ขอ้ความทั้งหมด 
 
   * Find : คน้หาขอ้ความ 
 
   * Find Next : คน้หาขอ้ความถดัไป 
 
  3.  Sketch Menu เป็นเมนูท่ีใชค้  าสั่ง Compile ,เพิ่มLibrary 
 
   * Verify/Compile : Compile ภาษา c/c++ เป็นภาษา Machine 
 
   * Stop : หยดุการ Compile 
 
   * Import Library : เลือก/เพิ่ม Library โดยแทรกในบรรทดัแรก 
 
   * Show Sketch Folders : ท าการแสดงท่ีเก็บโปรแกรม 
 
   * Add File.. : คดัลอก File เลือก/เพิ่มมาบนัทึกรวมใน Folder ปัจจุบนั 
 
  4. Tools Menu :ใชจ้ดั code ,เลือกเบอร์ Microcontroller ,เลือก port serial 
 
   * Auto Format : จดัวาง code ใหเ้ป็นระเบียบสวยงาม ใหอ่้านไดง่้ายโดยแยกสี code ท่ี
เป้นค าสั่งและตวัแปร 
 
   * copy to Forum : คดัลอก code ลง clipboard 
 
   * Archive Sketch : สั่งใหบี้บอดั Folder ปัจจุบนัเป็นไฟลบี์บอดั มีประโยชน์ในการท า 
CVS 
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   * Board : เลือก Hardware Device ท่ีใชง้านกบัโปรแกรม เช่น Arduino Nano เป็นตน้ 
 
   * Serial Ports : เลือก port เพื่อ communication ระหวา่ง Hardware Device กบั Arduino 
IDE 
 
   * Burn Bootloader : เพื่อท าการ bootloadder ให ้Hardware Device โดยตอ้งมีเคร่ือง 
burn 
 
 

3.4.4   การโหลดโปรแกรมลงบอร์ด 

1. เปิดโปรแกรม Arduino IDE ท่ีไดโ้หลดมาจาก 

http://arduino.cc/en/Main/Software 

2. เม่ือเปิดโปรแกรมแลว้จะพบกบัหนา้ต่างของ IDE ดงัรูป 

 

 

 

 

 

 

 

 

 

http://arduino.cc/en/Main/Software


 

 

 

 

 

 

 

 

52 

 

3. ไปท่ี Tools->Board แลว้เลือกใหต้รงกบับอร์ดท่ีใชง้าน ส าหรับ Arduino UNO 

R3 ใหเ้ลือกบอร์ด Arduino UNO 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

http://www.ec.in.th/index.php?route=product/product&product_id=1002
http://www.ec.in.th/index.php?route=product/product&product_id=1002
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4. เขียนโปรแกรม 

 
 

5. จากนั้นคอมไฟลโ์ปรแกรมโดยไปท่ี Sketch->Verify / Compile 
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6. เม่ือคอมไฟลเ์รียบร้อยจะมีขอ้ความปรากฎดงัรูป 

 
 

7. ต่อบอร์ด Arduino UNO R3 เขา้กบัคอมพิวเตอร์ผา่นทางพอร์ต USB 

 

 

 

 

 

 

 

 

 

http://www.ec.in.th/index.php?route=product/product&product_id=1002
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8. จากนั้นใหไ้ปท่ี Tools->Serial Port และเลือกใหต้รงกบับอร์ด Arduino UNO ท่ี

ใชง้าน (ส าหรับบอร์ด Arduino UNO R3 โปรแกรมจะเลือกใหอ้ตัโนมติั)  

 

9. โหลดโปรแกรมเขา้บอร์ด Arduino UNO โดยไปท่ี File->Upload 
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10. จากนั้นเปิด Serial Monitor ของ Arduino IDE โดยไปท่ี Tools->Serial Monitor 

 
 

11. เม่ือเปิด Serial Monitor จะไดข้อ้ความดงัรูป 
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บทที ่ 4 
การทดสอบประสิทธิภาพเคร่ืองวดัระดับแอลกอฮอล์ด้วยลมหายใจ 

 
4.1   บทน า 
 ในบทน้ีจะเป็นการทดลองเพื่อทดสอบประสิทธิภาพของเคร่ืองวดัระดบัแอลกอฮอลด์ว้ยลม
หายใจเทียบกบัเคร่ืองเป่าวดัแอลกอฮอล์ Intoximeters Alco-Sensor IV with Memory - Black DOT 

ท่ีได้มาตรฐานของโรงพยาบาล [1] ว่ามีความผิดพลาดมากน้อยเพียงใด สามารถน าไปใช้จริงได้
หรือไม่ เพื่อบรรลุวตัถุประสงคข์องโครงงาน 
 

4.2   อปุกรณ์ทีใ่ช้ในการทดลอง  
1.  เคร่ืองเป่าวดัแอลกอฮอลท่ี์ไดม้าตรฐาน ราคาประมาณ 25,000 บาท (รูปท่ี 4-1 (ก) ) 
2. เคร่ืองวดัระดบัแอลกอฮอลด์ว้ยลมหายใจ ราคาประมาณ 6,000 บาท (รูปท่ี 4-1 (ข) ) ดงัน้ี 

 บอร์ดไมโครคอนโทรเลอร์ Arduino UNO R3 (AT mega 328) 
 แผงวงจรเช่ือมต่อ Sensor TGS2620 
 แผงวงจรเช่ือมต่อ LCD 16x2 และสัญญาณเตือน (ออด + LED) 

 

      
(ก)     (ข) 

รูปท่ี 4-1   อุปกรณ์ท่ีใชใ้นการทดลอง 
 
 หมายเหต ุ: [1] งานคดีและนิติเวช โรงพยาบาลมหาราช จังหวดันครราชสีมา 
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4.3   วธิีการทดลอง  
 เราไดใ้ชอ้าสาสมคัรจ านวน 8 คน เป็นชายและหญิงดงัต่อไปน้ี 

 คนท่ี 1 เพศชาย ด่ืมเหลา้ 8 แกว้ 
 คนท่ี 2 เพศชาย ด่ืมเหลา้ 12 แกว้ 
 คนท่ี 3 เพศชาย ด่ืมเหลา้ 12 แกว้ 
 คนท่ี 4 เพศชาย ไม่ไดด่ื้ม 
 คนท่ี 5 เพศหญิง ด่ืมเหลา้ 7 แกว้ 
 คนท่ี 6 เพศหญิง ด่ืมเบียร์ 2 ขวด 
 คนท่ี 7 เพศหญิง ไม่ไดด่ื้ม 
 คนท่ี 8 เพศหญิง ไม่ไดด่ื้ม 

โดยจะท าการทดลองวดัระดบัแอลกอฮอล์ในร่างกายของอาสาสมคัรแต่ละคนกบัเคร่ืองวดั
ระดบัแอลกอฮอล์ดว้ยลมหายใจ จากนั้นก็จะให้ท าการทดลองวดักบัเคร่ืองเป่าวดัแอลกอฮอล์ท่ีได้
มาตรฐานของโรงพยาบาลทนัทีโดยไม่ให้อาสาสมคัรด่ืมเพิ่มเติม และบนัทึกผล โดยจะท าการ
ทดลองวัดค่าทั้ งหมดคนละ 5 คร้ังกับอุปกรณ์แต่ละตัว แล้วน ามาหาค่าเฉล่ียเพื่อลดความ
คลาดเคล่ือนใหน้อ้ยท่ีสุด 
 

4.4   ผลการทดลอง 
ผลการทดลองถูกบันทึกในรูปตาราง โดยแยกเป็นตารางผลการทดลองของแต่ละคน

ทั้งหมด 8 ตาราง เพื่อสะดวกต่อการวเิคราะห์ขอ้มูลดงัน้ี 
ตารางท่ี 4-1   คนท่ี 1 เพศชาย ด่ืมเหลา้ 8 แกว้ 

คร้ัง
ท่ี 

ค่าท่ีไดจ้ากเคร่ืองวดัระดบั
แอลกอฮอลด์ว้ยลมหายใจ 

(mg%) 

ค่าท่ีไดจ้ากเคร่ืองเป่าวดัแอลกอฮอล์
ท่ีไดม้าตรฐาน 

(mg%) 

เปอร์เซ็นต์
ความคลาด
เคล่ือน 

1 75 80 6.25 
2 77 82 6.09 
3 80 81 1.23 
4 78 82 4.88 
5 81 84 3.57 

เฉล่ีย 78.2 81.8 4.40 
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ตารางท่ี 4-2   คนท่ี 2 เพศชาย ด่ืมเหลา้ 12 แกว้ 
คร้ัง
ท่ี 

ค่าท่ีไดจ้ากเคร่ืองวดัระดบั
แอลกอฮอลด์ว้ยลมหายใจ 

(mg%) 

ค่าท่ีไดจ้ากเคร่ืองเป่าวดัแอลกอฮอล์
ท่ีไดม้าตรฐาน 

(mg%) 

เปอร์เซ็นต์
ความคลาด
เคล่ือน 

1 99 108 8.33 
2 107 112 4.46 
3 104 110 5.45 
4 105 109 3.67 
5 101 115 12.17 

เฉล่ีย 103.2 110.8 6.81 
 
 

ตารางท่ี 4-3   คนท่ี 3 เพศชาย ด่ืมเหลา้ 12 แกว้ 
คร้ัง
ท่ี 

ค่าท่ีไดจ้ากเคร่ืองวดัระดบั
แอลกอฮอลด์ว้ยลมหายใจ 

(mg%) 

ค่าท่ีไดจ้ากเคร่ืองเป่าวดัแอลกอฮอล์
ท่ีไดม้าตรฐาน 

(mg%) 

เปอร์เซ็นต์
ความคลาด
เคล่ือน 

1 108 112 3.57 
2 100 110 9.09 
3 107 110 2.73 
4 110 108 1.85 
5 99 109 9.17 

เฉล่ีย 104.8 109.8 5.28 
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ตารางท่ี 4-4   คนท่ี 4 เพศชาย ไม่ไดด่ื้ม 
คร้ัง
ท่ี 

ค่าท่ีไดจ้ากเคร่ืองวดัระดบั
แอลกอฮอลด์ว้ยลมหายใจ 

(mg%) 

ค่าท่ีไดจ้ากเคร่ืองเป่าวดัแอลกอฮอล์
ท่ีไดม้าตรฐาน 

(mg%) 

เปอร์เซ็นต์
ความคลาด
เคล่ือน 

1 13 12 8.33 
2 14 15 6.67 
3 13 14 7.14 
4 13 15 13.33 
5 12 14 14.28 

เฉล่ีย 13 14 9.95 
 

 
ตารางท่ี 4-5   คนท่ี 5 เพศหญิง ด่ืมเหลา้ 7 แกว้ 

คร้ัง
ท่ี 

ค่าท่ีไดจ้ากเคร่ืองวดัระดบั
แอลกอฮอลด์ว้ยลมหายใจ 

(mg%) 

ค่าท่ีไดจ้ากเคร่ืองเป่าวดัแอลกอฮอล์
ท่ีไดม้าตรฐาน 

(mg%) 

เปอร์เซ็นต์
ความคลาด
เคล่ือน 

1 77 74 4.05 
2 75 72 4.16 
3 74 78 5.13 
4 77 72 6.94 
5 75 72 4.16 

เฉล่ีย 75.6 73.6 4.89 
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ตารางท่ี 4-6   คนท่ี 6 เพศหญิง ด่ืมเบียร์ 2 ขวด 
คร้ัง
ท่ี 

ค่าท่ีไดจ้ากเคร่ืองวดัระดบั
แอลกอฮอลด์ว้ยลมหายใจ 

(mg%) 

ค่าท่ีไดจ้ากเคร่ืองเป่าวดัแอลกอฮอล์
ท่ีไดม้าตรฐาน 

(mg%) 

เปอร์เซ็นต์
ความคลาด
เคล่ือน 

1 85 88 3.40 
2 87 90 3.33 
3 85 91 6.59 
4 83 90 7.78 
5 91 89 2.25 

เฉล่ีย 86.2 89.6 3.79 
 
 

ตารางท่ี 4-7   คนท่ี 7 เพศหญิง ไม่ไดด่ื้ม 
คร้ัง
ท่ี 

ค่าท่ีไดจ้ากเคร่ืองวดัระดบั
แอลกอฮอลด์ว้ยลมหายใจ 

(mg%) 

ค่าท่ีไดจ้ากเคร่ืองเป่าวดัแอลกอฮอล์
ท่ีไดม้าตรฐาน 

(mg%) 

เปอร์เซ็นต์
ความคลาด
เคล่ือน 

1 15 14 7.14 
2 14 12 16.67 
3 14 14 0.00 
4 12 14 14.28 
5 14 15 6.67 

เฉล่ีย 13.8 13.8 8.95 
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ตารางท่ี 4-8   คนท่ี 8 เพศหญิง ไม่ไดด่ื้ม 
คร้ัง
ท่ี 

ค่าท่ีไดจ้ากเคร่ืองวดัระดบั
แอลกอฮอลด์ว้ยลมหายใจ 

(mg%) 

ค่าท่ีไดจ้ากเคร่ืองเป่าวดัแอลกอฮอล์
ท่ีไดม้าตรฐาน 

(mg%) 

เปอร์เซ็นต์
ความคลาด
เคล่ือน 

1 13 12 8.33 
2 14 13 7.69 
3 13 14 7.14 
4 12 13 7.69 
5 12 12 0.00 

เฉล่ีย 12.8 12.8 6.17 
  
 

4.5   วเิคราะห์ผลการทดลอง 
จากตารางท่ี 4-1 ถึง 4-2 เม่ือเราน าขอ้มูลทั้งหมดมาวิเคราะห์ภาพรวม โดยแสดงในตาราง

และกราฟดงัต่อไปน้ี 
 
ตารางท่ี 4-9   ขอ้มูลภาพรวมของอาสาสมคัรทั้ง 8 คน 

คนท่ี เปอร์เซ็นตค์วามคลาดเคล่ือนเฉล่ีย 
1 4.40 
2 6.81 
3 5.28 

4* 9.95* 
5 4.89 
6 3.79 

7* 8.95* 
8* 6.17* 
เฉล่ีย 6.28 

หมายเหต ุ: * คือข้อมลูของอาสาสมคัรท่ีไม่ได้ด่ืม 

 
น าขอ้มูลทั้งหมดไปเขียนกราฟเพื่อวเิคราะห์ภาพรวมไดช้ดัเจนยิง่ข้ึน ดงัต่อไปน้ี 
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รูปท่ี 4-2   กราฟแสดงขอ้มูลภาพรวมของค่าความคลาดเคล่ือนคิดเป็นเปอร์เซ็นต ์
 
ส าหรับเกณฑ์ท่ียอมรับได้นั้น กรมวิทยาศาสตร์การแพทยก์ าหนดให้เคร่ืองมือตรวจวดั

ปริมาณแอลกอฮอล์ในกระแสเลือดตอ้งมีความคลาดเคล่ือนจากมาตรฐานไดไ้ม่เกิน 5% จึงจะถือวา่
เคร่ืองสามารถอ่านผลการตรวจไดอ้ยา่งถูกตอ้งและมีความแม่นย  าสูงสุด ซ่ึงจะท าให้เกิดความมัน่ใจ
ในผลการวดัของทั้งผูต้รวจและผูรั้บการตรวจ [2] 

จากกราฟท่ี 4-1 จะเห็นว่ามีค่าเปอร์เซ็นต์ความคลาดเคล่ือนของอาสาสมคัรท่ีเกินกว่าค่า
มาตรฐาน (5%) อยู่มาก รวมถึงค่าเฉล่ียของเปอร์เซ็นต์ความคลาดเคล่ือนทั้งหมดก็อยู่ท่ี 6.28 ซ่ึงถือ
วา่เกินมาตรฐานท่ีกรมวทิยาศาสตร์การแพทยก์ าหนดไวอ้ยู ่

 
หมายเหตุ :  [2] การสอบเทียบเคร่ืองวัดแอลกอฮอล์ในเลือดจากลมหายใจ โดย ธีรวัฒน์   สุภาวฒันพันธ์  

และ ลกัษณา   ลือประเสริฐ ศูนย์วิทยาศาสตร์การแพทย์ขอนแก่น กรมวิทยาศาสตร์การแพทย์ 
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หากสังเกตตารางท่ี 4-9 จะเห็นว่าข้อมูลท่ีมีเคร่ืองหมาย * ก ากับเป็นข้อมูลท่ีได้มาจาก
อาสาสมคัรท่ีไม่ไดด่ื้มทั้งหมด 3 ขอ้มูล ซ่ึงพบวา่มีค่าเฉล่ียของเปอร์เซ็นตค์วามคลาดเคล่ือนท่ีสูงมาก 
เน่ืองจากตวัเลขเปอร์เซ็นตมิ์ลลิกรัมท่ีวดันั้นไดต้วัเลขค่านอ้ย ประกอบกบัเคร่ืองมือวดัทั้งสองอนันั้น
ไม่สามารถแสดงจุดทศนิยมได ้ตวัเลขขอ้มูลทั้งสองจึงมีความต่างกนัมากหากคิดเป็นเปอร์เซ็นต ์ซ่ึง
ท าให้ได้ค่าเปอร์เซ็นต์ความคลาดเคล่ือนท่ีสูงมากตามไปด้วย และหากมองในทางปฏิบัติแล้ว
เคร่ืองวดัระดบัแอลกอฮอลท์ั้งสองเคร่ืองน้ีจะใชเ้พื่อหาระดบัแอลกอฮอล์ในร่างกาย ดงันั้นเราจึงลอง
พิจารณาเฉพาะขอ้มูลจากอาสาสมคัรท่ีด่ืมเท่านั้น ซ่ึงจะไดค้่าเฉล่ียของเปอร์เซ็นตค์วามคลาดเคล่ือน
ลดลงมาเป็น 5.034 น ามาเขียนกราฟจะไดด้งัน้ี 

0

2

4

6

8

      1       2       3       5       6

                                          

                                   

                                                

 
กราฟท่ี 4-3   แสดงขอ้มูลภาพรวมของค่าความคลาดเคล่ือนคิดเป็นเปอร์เซ็นตเ์ม่ือแยก

วเิคราะห์ขอ้มูลจากอาสาสมคัรท่ีมีการด่ืมเท่านั้น 
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จากกราฟท่ี 4-2 จะเห็นว่าค่าเฉล่ียของเปอร์เซ็นต์ความคลาดเคล่ือนทั้ งหมดสูงกว่าค่า
มาตรฐาน (5%) เพียง 0.034 เท่านั้น ซ่ึงถือวา่นอ้ยมาก 
 

 
4.6   สรุปผลการทดลอง 
 จากการทดสอบประสิทธิภาพเคร่ืองวดัระดบัแอลกอฮอล์ดว้ยลมหายใจเทียบกบัเคร่ืองเป่า
วดัแอลกอฮอล์ท่ีได้มาตรฐานของโรงพยาบาล โดยใช้อาสาสมัครจ านวน 8 คน ท่ีมีสภาวะ
แอลกอฮอล์ในร่างกายท่ีแตกต่างกนั ทั้งน้ีไดพ้ิจารณาเพียงสองกรณีคือ อาสาสมคัรท่ีด่ืมเหลา้ และ
ไม่ได้ด่ืมเหล้า โดยท าการทดสอบต่ออาสาสมัคร 1 คนมากกว่าหน่ึงรอบ แต่ละรอบจะต้องใช้
เคร่ืองวดัทั้ งสองอนัในช่วงเวลาไล่เล่ียกันโดยไม่ให้อาสาสมัครด่ืมเพิ่มและไม่ค  านึงถึงปริมาณ
แอลกอฮอลท่ี์แต่ละคนไดด่ื้มมา ผลการทดลองท่ีไดอ้ยูใ่นรูปของเปอร์เซ็นตค์วามคลาดเคล่ือนท่ีเม่ือ
น ามาหาค่าเฉล่ียไดเ้ท่ากบั 6.28 ซ่ึงเกินค่ามาตรฐานของกรมวิทยาศาสตร์การแพทยท่ี์ก าหนดไวคื้อ 
ไม่เกิน 5% แต่เรามองในทางปฏิบติัเน่ืองจากเคร่ืองวดัทั้งสองอนัใชส้ าหรับวดัระดบัแอลกอฮอลใ์นผู ้
ท่ี ด่ืมมาเป็นหลัก ดังนั้ นจึงพิจารณาเฉพาะข้อมูลของอาสาสมัครท่ีมีการด่ืมซ่ึงได้ค่าเฉล่ียของ
เปอร์เซ็นตค์วามคลาดเคล่ือนลดลงมาอยูท่ี่ 5.034 ซ่ึงเกินค่ามาตรฐานของกรมวิทยาศาสตร์การแพทย์
อยู ่0.034 อยา่งไรก็ตามก็ยงัถือวา่นอ้ยมากและสรุปไดว้า่เคร่ืองวดัระดบัแอลกอฮอล์ดว้ยลมหายใจท่ี
พฒันาข้ึนน้ีมีประสิทธิภาพท่ีใกลเ้คียงกบัเคร่ืองเป่าวดัแอลกอฮอลท่ี์ไดม้าตรฐาน 
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บทที ่ 5 
สรุปผลการทดลองและข้อเสนอแนะ 

 
5.1   บทน า  
 เน้ือหาในบทน้ีเป็นการกล่าวถึงบทสรุปของโครงงานเคร่ืองวดัระดบัแอลกอฮอล์ดว้ยลม
หายใจ ซ่ึงประกอบด้วยขอ้สรุปของโครงงาน ปัญหาท่ีพบขณะด าเนินงาน วิธีแก้ปัญหา ตลอดจน
ขอ้เสนอแนะและวธีิพฒันาโครงงานต่อไป 

 
5.2   บทสรุปผลของโครงงาน 
 เคร่ืองวดัระดบัแอลกอฮอล์ดว้ยลมหายใจท่ีสร้างข้ึนในโครงงานน้ี มีส่วนประกอบหลกัๆ 
ดงัน้ี 1.) บอร์ดไมโครคอนโทรเลอร์ Aduino UNO R3  2.) เซ็นเซอร์วดัแอลกอฮอล์ TGS 2620  3.) 
จอ LCD  4.) ตวัแจง้เตือนไดแ้ก่ LED และออด โดยมีหลกัการท างานคือ เม่ือเราเป่าลมหายใจไปยงั
ตัวเซ็นเซอร์ ตัวเซ็นเซอร์จะสามารถตรวจจับแอลกอฮอล์ท่ีออกมากับลมหายใจ จากนั้ นตัว
ไมโครคอนโทรลเลอร์ท่ีถูกลงโปรแกรมไวด้ว้ยพื้นฐานภาษา C จะท าการแปรผลการค านวณออกมา
เป็นหน่วยเปอร์เซ็นต์มิลลิกรัม (%mg) แลว้แสดงออกท่ีจอ LCD ซ่ึงหากผลท่ีไดเ้กิน 50 เปอร์เซ็นต์
มิลลิกรัม โปรแกรมก็จะสั่งใหอ้อดมีเสียงเตือนเกิดข้ึนพร้อมกบั LED กะพริบดว้ย 
 การทดสอบประสิทธิภาของเคร่ืองวดัระดบัแอลกอฮอล์ดว้ยลมหายใจ ไดท้  าการทดสอบ
เทียบกบัเคร่ืองเป่าวดัแอลกอฮอลเ์คร่ืองจริงท่ีไดม้าตรฐาน โดยการทดสอบไดใ้ช้อาสาสมคัรจ านวน 
8 คนมาท่ีมีสภาวะแอลกอฮอล์ในร่างกายแตกต่างกนั ทั้งน้ีไดพ้ิจารณาเพียงกรณีด่ืมกบัไม่ด่ืมเท่านั้น 
และให้แต่ละคนท าการวดักบัเคร่ืองทั้งสองในเวลาไล่เล่ียกนัโดยมิให้ด่ืมเพิ่ม ซ่ึงแต่ละคนจะถูกท า
การวดัแอลกอฮอล์คนละ 5 รอบ แลว้น ามาหาค่าเฉล่ียและค่าเปอร์เซ็นต์ความผิดพลาดเปรียบเทียบ
กนั จากผลการทดลองพบวา่ เคร่ืองวดัระดบัแอลกอฮอล์ดว้ยลมหายใจท างานไดใ้กลเ้คียงกบัเคร่ือง
เป่าวดัแอลกอฮอล์ท่ีได้มาตรฐาน ทั้ งน้ีเม่ือลองน าข้อมูลท่ีเป็นตวัเลขไปเปรียบเทียบกันเพื่อหา
เปอร์เซ็นต์ความคลาดเคล่ือน พบว่าอยู่ในเกณฑ์ท่ีใกล้เคียงมาตรฐาน จึงสรุปได้ว่า เราสามารถ
ประยุกต์ใช้ความรู้ด้านไมโครคอนโทรลเลอร์ ความรู้ทางไฟฟ้า และการโปรแกรมคอมพิวเตอร์
ภาษา C สร้างเคร่ืองวดัระดบัแอลกอฮอล์ดว้ยลมหายใจท่ีมีประสิทธิภาพและสามารถน าไปใชง้าน
ไดจ้ริง ดว้ยตน้ทุนท่ีถูกกวา่ราคาของเคร่ืองท่ีไดม้าตรฐานอยา่งมาก 
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5.2   ปัญหาและอปุสรรค 
 

ปัญหาและอุปสรรค วธีิแก้ไข 
1.   การคืนค่าของเซนเซอร์ บางตวัอาจตอ้งทิ้ง
ระยะห่างในการวดัค่าท่ีนานพอสมควร จึงไม่
เหมาะท่ีจะน ามาใชก้บัโครงงาน 

1.   จากการศึกษาขอ้มูลพบวา่เซนเซอร์ท่ี
เหมาะสม และระยะเวลาในการคืนค่าไม่
นานมาก คือ TGS 2620 จึงเปล่ียนมาใช้
เซนเซอร์ตวัน้ี 

2.   ความช้ืนท่ีเกิดจากการเป่าลมไปท่ีเซนเซอร์ อาจ
มีน ้าลายหรือไอระเหยของแอลกอฮอลท่ี์ออกมากบั
ลมหายใจ ซ่ึงจะท าใหเ้กิดความช้ืน ท าใหก้ารใช้
งานเซนเซอร์บกพร่องได ้

2.   ออกแบบใหบ้ริเวณท่ีใชเ้ก็บเซนเซอร์
สามารถเปิดออกเพื่อเช็ดท าความสะอาดได ้

3.   ปัญหาท่ีเกิดจากเคร่ืองเป่าวดัแอลกอฮอลข์อง
โรงพยาบาลเองท่ีไม่ไดม้าตรฐาน 

3.   ท าเร่ืองขอยมืเคร่ืองเป่าวดัแอลกอฮอล์
จากทางโรงพยาบาลไปสามคร้ัง จนได้
เคร่ืองท่ีมีมาตรฐานมาท าการทดลอง 

4.   การหาสมการจากกราฟคุณลกัษณะของ
เซนเซอร์ท่ีก๊าซค่าต่างๆ อาจมีขอ้ผดิพลาดเกิดข้ึน 
เน่ืองจากเราหาค่าสมการจากการพิจารณาแนวโนม้
ของกราฟ 

4.   ในขั้นตอนการหาสมการจากกราฟ
คุณลกัษณะของเซนเซอร์ จะท าดว้ยความ
ละเอียดรอบคอบท่ีสุด 

 
 

5.3   ข้อเสนอแนะ 
1. ถา้ตอ้งการใหเ้ห็นสัญญาณไฟท่ีชดัเจนข้ึน สามารถเพิ่มจ านวน LED ได ้

2. สามารถเพิ่ม Function ให้กบัเซนเซอร์ไดม้ากข้ึนอีก หรือเปล่ียนเป็นเซนเซอร์ท่ีมีคุณภาพ
ยิง่ข้ึนแต่ราคาก็สูงข้ึนดว้ย 

3. สามารถปรับรูปแบบใหใ้ชถ่้านพลงังานแทนใชไ้ฟบา้นได ้ เพื่อการสะดวกในการพกพา 
4. สามารถเขียนโปรแกรมใหจ้อ LCD Freeze ค่าสูงสุดไวเ้พื่อสะดวกต่อการอ่านค่า 
5. เซนเซอร์ TGS 2620 สามารถตรวจจบัแก๊สไดห้ลายชนิด ไม่เฉพาะแอลกอฮอล ์ดงันั้นหากมี

รูปสมการหรือรูปกราฟอ่ืนๆท่ีเซนเซอร์สามารถตรวจจบัได้ ก็สามารถน ามาใช้เขียน
โปรแกรมลงบนบอร์ดเพื่อใชง้านตรวจจบัแก๊สดงักล่าวได ้
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บรรณานุกรม 
 

บทความเร่ือง แอลกอฮอล ์โดย เลียงชยั  จตุัรัส ภาควชิานิติเวชศาสตร์ คณะแพทยศาสตร์ 
มหาวทิยาลยัขอนแก่น 

แอลกอฮอล ์จาก http://vcharkarn.com/varticle/41018 
หลกัการเบ้ืองตน้ของเซนเซอร์ จาก http://www.thaieasyelec.com/Review-Product-

Article/Gas-Sensor-Getting-Started.html 
การตรวจวดัแอลกอฮอล ์จาก http://www.sri.cmu.ac.th/~srilocal/drugs/knowledge-

details.php?knowledge_id=28 
ไมโครคอนโทรลเลอร์ จาก http://th.wikipedia.org/wiki/ไมโครคอนโทรเลอร์ 

 ไมโครคอนโทรเลอร์ จาก http://www.duinothumb.com/articles/intromicrocontroller 
 Arduino จาก http://www.thainetbeans.com/arduino/start/start.php 
 Arduino จาก http://www.duinothumb.com/articles/platform-arduino-open-hard 
 Arduino กบับอร์ดไมโครคอนโทรลเลอร์ จาก 
http://www.ec.in.th/index.php?route=cms/article&article_id=34 
 ออดกล จาก http://thai.alibaba.com/product-gs/mechanical-buzzer-emb-2306l--
216662761.html 
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http://thai.alibaba.com/product-gs/mechanical-buzzer-emb-2306l--216662761.html
http://thai.alibaba.com/product-gs/mechanical-buzzer-emb-2306l--216662761.html
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ประวตัิผู้เขยีน 
 

นางสาวกฤติกาญจน์ สุวรรณสิทธ์ิ เกิดเม่ือวนัท่ี 3 พฤษภาคม พ.ศ.
2534 ภูมิล าเนาอยูท่ี่ 29/5 หมู่ 1 ต.หนองน ้ าแดง อ.ปากช่อง จงัหวดั
นครราชสีมา ส าเร็จการศึกษาระดบัมธัยมตอนปลายจากโรงเรียน
มธัยมวชิราลงกรณวราราม อ.ปากช่อง จงัหวดันครราชสีมา ปัจจุบนั
เป็นนักศึกษาชั้นปีท่ี 4 สาขาวิศวกรรมโทรคมนาคม ส านักวิชา
วิศวกรรมโทรคมนาคม มหาวิทยาลัยเทคโนโลยีสุรนารี จงัหวดั
นครราชสีมา 

 
 
นางสาวกนิษฐา  ก่อสัมพนัธ์กุล เกิดเม่ือวนัท่ี 1 มกราคม พ.ศ.2535 
ภูมิล าเนาอยู่ท่ี 199 หมู่ 3 ต.มหาวนั อ.แม่สอด จงัหวดัตาก ส าเร็จ
การศึกษาระดบัมธัยมตอนปลายจากโรงเรียนจุฬาภรณ์ราชวิทยาลยั 
พิษณุโลก อ.เมือง จงัหวดัพิษณุโลก ปัจจุบนัเป็นนกัศึกษาชั้นปีท่ี 4 
สาขาวิศวกรรมโทรคมนาคม ส านักวิชาวิศวกรรมโทรคมนาคม 
มหาวทิยาลยัเทคโนโลยสุีรนารี จงัหวดันครราชสีมา 
 

 
 

นายนุ๊ก  สาสังข ์เกิดเม่ือวนัท่ี 26  ธนัวาคม พ.ศ.2532 ภูมิล าเนาอยูท่ี่ 
456/3 หมู่ 2 ต.ชุมแพ อ.ชุมแพ จงัหวดัขอนแก่น ส าเร็จการศึกษา
ระดบัมธัยมตอนปลายจากโรงเรียนนครขอนแก่น อ.เมือง จงัหวดั
ขอนแก่น  ปั จ จุบัน เป็นนัก ศึกษ าชั้ น ปี ท่ี  4 ส าขาวิศวกรรม
โทรคมนาคม ส านักวิชาวิศวกรรมโทรคมนาคม มหาวิทยาลัย
เทคโนโลยสุีรนารี จงัหวดันครราชสีมา 
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ภาคผนวก ก 
ภาพอปุกรณ์วดัระดับแอลกอฮอล์ 

 
 

 
 

เคร่ืองวดัระดบัแอลกอฮอลด์ว้ยลมหายใจ 
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เคร่ืองเป่าวดัแอลกอฮอลท่ี์ไดม้าตรฐาน 
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ภาคผนวก ข 
เอกสารการสอบเทยีบเคร่ืองวดัแอลกอฮอล์ในเลอืดจากลมหายใจ 

 
ธีรวฒัน์   สุภาวฒันพนัธ์      และ ลกัษณา   ลือประเสริฐ  
ศูนยว์ทิยาศาสตร์การแพทยข์อนแก่น กรมวทิยาศาสตร์การแพทย ์
 
              สถิติจ านวนอุบติัเหตุและความรุนแรงท่ีเกิดจากการจราจร มีแนวโน้มเพิ่มข้ึนทั้งปริมาณ
และความรุนแรง สาเหตุส่วนใหญ่มาจากความประมาท การไม่ปฏิบติัตามกฎจราจร และด่ืมสุราแลว้
ขบัรถ ท าให้เกิดความสูญเสียทางด้านสังคมและเศรษฐกิจท่ีใช้ในการรักษาดูแลผูเ้จ็บป่วยและผู ้
พิการ  ดงันั้นการตรวจวดัปริมาณแอลกอฮอล์ในเลือดจากลมหายใจในผูข้บัข่ีเป็นมาตรการหน่ึงท่ี
ส าคญัในการป้องกนัอุบติัเหตุดงักล่าว โดยให้ผูถู้กตรวจวดัเป่าลมหายใจเขา้เคร่ืองฯซ่ึงมีตวัตรวจจบั
(Detector)แอลกอฮอล์อยู่ หากตรวจพบว่ามีแอลกอฮอล์อยู่ในลมหายใจ เคร่ืองฯจะค านวณและ
แปลงให้เป็นค่าแอลกอฮอล์ท่ีมีอยู่ในเลือด (Blood/Breath ratio = 2000:1)   ศูนย์วิทยาศาสตร์
การแพทย์ขอนแก่น ได้ด าเนินการสอบเทียบเคร่ืองวดัระดับแอลกอฮอล์ในเลือด เพื่อให้เคร่ือง
สามารถอ่านผลการตรวจไดอ้ย่างถูกตอ้งและมีความแม่นย  าสูงสุด มีความคลาดเคล่ือนจากเกณฑ์
มาตรฐานไม่เกิน + 5 % ซ่ึงจะท าให้เกิดความมัน่ใจในผลการวดัของทั้งผูต้รวจและผูรั้บการตรวจ 
โดยไดท้  าการศึกษาประสิทธิภาพของเคร่ืองทั้งก่อนและหลงัการสอบเทียบ กบัเคร่ืองใหม่ท่ียงัไม่
เคยใชง้านมาก่อนรวมทั้งเคร่ืองท่ีเคยใชง้านมาแลว้  จากผลการตรวจสอบท่ีผา่นมาตั้งแต่ปี 2541 ถึง 
2545 ไดด้ าเนินการตรวจแลว้ทั้งหมดรวม 77 เคร่ือง เป็นเคร่ืองใหม่จ  านวน 22 เคร่ือง และเคร่ืองท่ี
เคยใช้งานมาแลว้จ านวน 55 เคร่ือง โดยค่าก่อนสอบเทียบมีค่าความคลาดเคล่ือน –2.0% ถึง +2.0%        
และ –5.0% ถึง +6.7% ตามล าดบั ส่วนค่าหลงัการสอบเทียบแลว้มีค่าความคลาดเคล่ือน –0.5% ถึง 
+0.5% และ –0.8% ถึง +0.5% ตามล าดบั  ซ่ึงการศึกษาน้ีพบว่าค่าความคลาดเคล่ือนหลงัการสอบ
เทียบของเคร่ืองใหม่ท่ียงัไม่เคยใช้งานกบัเคร่ืองท่ีเคยใช้งานมาแล้ว มีค่าแตกต่างกนัน้อยมากเม่ือ
เทียบกบัค่ามาตรฐานท่ีตั้งไว ้ 
               เพื่อคงไวซ่ึ้งความมัน่ใจในผลการตรวจวดัของทั้งผูต้รวจและโดยเฉพาะต่อผูไ้ด้รับการ
ตรวจถึงสิทธิท่ีจะไดรั้บความคุม้ครองท่ีชอบธรรมดว้ยมาตรฐานในระดบัสากล และเพื่อเป็นการ
รักษาประสิทธิภาพของเคร่ืองตรวจวดัระดบัแอลกอฮอล์ในเลือดจากลมหายใจ ให้มีความถูกตอ้ง
แม่นย  าอยูเ่สมอ จ าเป็นตอ้งน าเคร่ืองฯมาเขา้รับการสอบเทียบคุณภาพเป็นประจ าทุกๆ 6 เดือน 
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ภาคผนวก ค 
ข้อมูลเชิงเทคนิคของเซนเซอร์ TGS 2620 
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